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ICAP/4Rx

New Features Overview
ICAP/4Rx delivers a host of new and enhanced
features including new interactive simulation
capabilities and improved integration between
the schematic, simulation, and post processor.

New Interactive SPICE...
SPICE Like You’ve Never Seen Before
ICAP/4Rx contains IsSpice4, the first and
only interactive version of SPICE

Real Time Waveform Display:
View circuit waveforms as the simulation
runs. Add, delete, or rescale waveforms at
any time.

Full Native Mixed Mode Capability:
IsSpice4 combines the SPICE 3 core with a
12-state digital logic simulator to allow mixed
analog and digital circuits to be simulated at
the same time.

Use New C Code Models:
Access user/vendor developed models
written in a C language- based HDL. Over
50  code models are already included.

Control The Simulation:
Start, stop, pause, or resume the simulation at
will. Interactively run different simulations and
alter values using powerful scripts.

Interactive Stimulus:
Sweep single parameters or groups of
interdependent parameters and watch the
circuit performance changes.
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The Biggest and Best Model
Libraries
16,000+ Models:
The main ICAP/4Rx  libraries, along with
the additional vendor-supplied IC/Op-Amp
models, Power Designer’s Library, and RF
Device library, contain over 16, 000 models.

Modeling Support:
The Intusoft technical support staff makes
SPICE models for registered customers.

Unparalleled Power In
The Schematic

Multiple Configurations:
Place design variations and production
drawings in a single schematic.

Multiple Simulation Setups:
Save several sets of analyses and combine
them with various circuit configurations to
make multiple  test scenarios.

Interactive Cross-Probing:
Cross-probe is enabled after the end of
 the simulation.

Analysis and Convergence Wizards:
Create your analysis statements and
overcome convergence problems
automatically.

Attribute, Model, Subcircuit Editing:
On-the-fly editing of all SPICE attributes
alleviates the need to know SPICE syntax.
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Introduction
Welcome to Intusoft’s circuit simulation environment for
Windows 98SE/ME and NT/2000/XP. This manual provides
complete installation instructions and a complete tutorial guide
for the ICAP/4Rx simulation system.

We would like to thank you for purchasing the Intusoft circuit
simulation system. As you already know, circuit simulation is an
important part of the overall circuit design task. The ICAP/4Rx
simulation system will provide you with capabilities that will
save you money, improve your understanding of your circuit
designs, and shorten your design cycle.

What’s In the ICAP/4Rx Package

Your package should include:

ICAP/4Rx CD-ROM
ICAP/4Rx Getting Started Book

The ICAP/4Rx Deluxe Option also includes either the RF (or
Power) Device Models, Working with Model Libraries including
SpiceMod5 for Windows, and the following materials:

Spice Applications Handbook (CD)
A Spice Cookbook (Manual  plus CD)

Hardware & Software Requirements

• Windows 98SE/ME or Windows 2000/XP/Vista
• Any  computer with Intel or AMD processor
• Hard disk (approximately 25 megabytes of free disk space)
• At least 128 megabytes of RAM, or more,  recommended
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Hardware Protection Key Installation

For non-U.S. and Canadian customers, a copy protection
key MUST be connected to your computer before the
software is installed.

To install the copy protection key;

• Connect the key to the computer’s parallel port.

The key has a 25-pin connector at each end and should be
plugged directly into your parallel port. The key should be
located as close to the port on the back of the computer as
possible. If you already have an output device connected to the
parallel port, install the key between the device and the port.
The protection key is transparent to other users of the parallel
port and does not interfere with data sent to or from the port.

DO NOT LOSE THIS KEY! The ICAP/4Rx software package
can not be run without it.

Troubleshooting Hardware Protection Key Operation
Although every effort has been made to ensure the highest
levels of quality and compatibility, the protection key, like any
other PC peripheral, might not run on certain PC configurations.

If you have a problem with the key, it can usually be overcome by
checking the following:

1) Are the key and parallel printer card connected, and are their screws
properly fastened? If they are not, reseat them.

2) Is a printer connected to the same port as the key? If so, does it work
properly? (Although this is a good sign, it does not necessarily mean
that the port and the printer are fully operational). If there is a printing
problem, try using another printer cable or another printer.

3) Make sure you’re using the latest version of the HASP driver.
Updates are available on the web www.intusoft.com/support.htm.
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Installing ICAP/4Rx

CD Installation
• Insert the ICAP/4Rx CD-ROM into the CD drive. A Welcome

program should start automatically.

If it doesn’t, navigate to the root of the CD-ROM drive and
run the “Setup.Exe” program.

• Follow the instructions.

When complete, all software will be installed in the SPICE8
directory as shown above. The IS, PR, SN, IN, and (optional)
SM directories under the SPICE8 directory must not have their
names changed; the SPICE8 directory name may be customized
at the time when the software is installed.

Installing Network Versions of ICAP/4Rx

• Please refer to the ICAP/4Rx Network instructions which
are  included within the server software setup.

HARDWARE PROTECTION KEY INSTALLATION: PC
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Registration Information

Contained in this package is the Intusoft Software Registration
card. In order to receive the Intusoft Newsletter, you must return
this registration card.  The Intusoft Newsletter is a valuable
resource for modeling and simulating hints, and is your primary
notification of product updates.

Please take this opportunity to fill out and mail or FAX your
registration form to us.

Included with your software shipment are the following items:

Intusoft Newsletter, Newsletter Subscription Order Form,
License Agreement  and Software Registration Card.

Viewing Readme Files

The SPICE8 directory contains a Readme file which provides
important information and last-minute documentation updates.
Please read it before proceeding.

Where to Go for Information

SpiceNet, Schematic Entry - The SpiceNet schematic entry
program is discussed in this Getting Started manual.

IsEd, Netlist Editing - The text editor is described in this
Getting Started manual.  It can be used to create or edit a circuit
netlist which you wish to simulate, to review  the simulation’s
output text file, or to create or edit any other text files, such as
SPICE model library files.

IsSpice4, Simulation - To brush up on the many details of
simulating circuits with IsSpice4 and the syntax associated with
an IsSpice4 netlist description, refer to the IsSpice4 User’s
Guide or the IsSpice4 tutorial in this manual.  An overview of the
mixed mode simulation features can be found in this manual.
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IntuScope5 - The on-line help contains a complete description
of each menu function.  Also see the chapter dedicated to
IntuScope5 in this book.

Tutorials -- This book contains examples which will help get
you simulating in the minimum amount of time. In-depth tutorials
on IsSpice4, SpiceNet and IntuScope5 provide a comprehensive
rundown. The Simulation Examples chapter provides over 25
different sample simulations which cover various topics.

Models -- The Parts Browser dialog in the SpiceNet schematic
entry program contains a complete listing of every model which
is supported in your installed version, including any optional
libraries which you have purchased.

Code Models--An overview is contained in the IsSpice4 User’s
Guide.  Several examples are in the Getting Started manual in
the Analog and Mixed Simulation Examples chapter.
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TUTORIAL # 1 - INTRODUCTION TO ICAP/4

Tutorial #1 - Introduction to ICAP/4

This chapter will familiarize you with ICAP/4’s SpiceNet
schematic capture program. SpiceNet is designed to
dramatically ease the process of generating SPICE netlists.
Netlists are necessary to run circuit simulations.

Now Launch SpiceNet to get started.

• Select the Windows Start (Programs) entry.

• Choose the (ICAP_4) program group, (Start ICAPS)
program.

Menu Bar

Toolbar

Tool Palette

If you are running your computer at a screen resolution greater
than 1024 by 768 you will need to re-size the SpiceNet window
to fill the entire computer screen. Move your mouse cursor to
the edge of the SpiceNet window. The cursor will change into
a double arrow cursor and you will be able to stretch the window
by holding down the left mouse button and moving the mouse.
Drag the title bar to reposition the window.

Active Layer
View Layer
Contents
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IsSpice4 Requirements for Simulation

To perform an IsSpice4 simulation, you must produce a netlist,
which has the following elements:

• Title line and .END line
• Component connectivity and attributes
• Stimulus, power, and ground
• IsSpice4 control statements (i.e., via the Simulation Setup

dialog)
• Output control statements (i.e., from Test Point symbols)

Note:  Each circuit element must have a path to ground.

SpiceNet will take care of the Title line, .END statement and the
circuit connectivity, which consists of unique reference
designations for each device and the numbering of each node.
You must add the following:

1) Component attributes
2)   Stimulus, power, and ground
3)   IsSpice4 control statements
4) Output control statements

Remember: If even one of the four key pieces is missing,
you will not be able to run a simulation.

Let’s set your preferred SpiceNet window size and position.

• Use the mouse to re-size and reposition the SpiceNet
window.

• From the Options Menu, select Save Preferences.

Additional SpiceNet settings you can save are:
1) Ruler on/off
2)   Grid on/off and grid size
3)   Drawing Page Size
4) Drawing Item Colors
5) Rubberbanding on/off
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Opening an Existing Project in SpiceNet

Let’s open a sample schematic (.DWG file) to work with:

• From the File menu, choose open and navigate to the
:\spice8\sn\sample2 directory.

• Left click on the Sample.DWG, then select Open

SpiceNet
schematic files
have a .DWG
extension.

SpiceNet
Tool bar

TUTORIAL # 1 - INTRODUCTION TO ICAP/4
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Running a Simulation

Let’s run our first simulation on the Sample.DWG

• From  the Actions Menu, select Simulate, or  click on the
Run Simulation icon in the SpiceNet toolbar.

This launches IsSpice4 and runs a simulation on the Sample
circuit. The IsSpice4 Window consists of four separate windows,
each with its own scroll bar:

Setting Preferences in IsSpice
We can now set preferences for the placement of these windows
that monitor the simulator’s results. (note: the waveform window is
not the full “IntuScope” waveform viewing window covered later)

• Stretch the IsSpice4 window to the desired size.

• From the Options Menu, select  Auto Size Windows.

• Drag the Simulation Control window to allow you to see
other windows. (While holding down the left mouse key in the
window banner, move the mouse to drag)

Run Simulation
icon.

IsSpice4
functions are
discussed in
detail in the
IsSpice4
Tutorial.

Output
Window

Simulation
Status
Window

Simulation
Control
Window

Error and
Status
Window
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Changing Projects
SpiceNet allows you to have multiple projects opened concurrently,
Therefore, for instance, you can change simulation options on a
desired project, then simulate without having to close other projects.
Switch between different projects by clicking on the schematic.

For example, tile or cascade your
schematics and click on the one you
want to become your Active Project.

If you maximize a schematic window, the
currently selected (active) schematic will
show in the title bar in brackets. Several
schematic manipulation functions are in
the Windows drop down menu.

Using SpiceNet Help

If you get into trouble during  SpiceNet, you can access the help
files from the Help drop down menu.  You can also quit SpiceNet
without saving changes.

• Select the Help menu, SpiceNet Help (<Ctrl>+H)

• Or, Select the File menu, Exit / Quit

If this is your first time using SpiceNet, you can also watch the
tutorial movies  available from the SpiceNet Help menu.

TUTORIAL # 1 - INTRODUCTION TO ICAP/4

This is the
SpiceNet
Toolbar.

Active project

Project name and
configuration

• From the Options Menu, select Save Preferences.

Next time a simulation is run, the IsSpice4 Windows will open in
the same position.
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SpiceNet Mouse and Keyboard Functions

The following two tables summarize the most common SpiceNet
mouse functions and keyboard commands. Select Hotkeys
from the Help Menu for a complete keyboard command list.

The following tutorials will familiarize you with the mouse and
keyboard  functions.

Mouse Usage

Desired Action Mouse Action
Place a pointer box Click the left mouse button.
(determines where the next
part will be placed)

Pan the schematic Press and hold the left mouse button until the pan
cursor appears, then drag the mouse.

Select an object Click the left mouse button over an object
until the object is highlighted.

Create a selection region Press and hold the left mouse button, dragging the
mouse over the desired region.

Select/Deselect Objects Shift-click on the object to select/deselect.

Move an object Press and hold the left mouse button over an object
until the object is highlighted.  Move the mouse.
Release the mouse button to place the object.

Add Part Values Double-click on a part, then type the value.

Change Node Numbers Select a part that is connected to the node, then
click the right mouse button, and select the “Node
Names...” function.

Zoom In and Out Click the right mouse button, then select the desired
zoom level.
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Keyboard Command Usage

Common Actions Key To Press
Open Parts Browser Press X, then select the part, or select Find
Place Passive Parts Press the IsSpice4 keyletter (R, L, C, etc.)
Wiring Tool Press W
Bus Tool Press 2, then press W
Ground Press O (the letter “o”, not the number zero)
Test Points (.PRINT) Press Y (voltage),

Press 2, then press Y (differential voltage),
Press 3, then press Y (current),
Press 4, then press Y (power)
Press 6, then press Y (current subcircuit)

Rotate an object Press + (plus key) after selecting the part(s)
Flip an object Press - (minus key) after selecting the part(s)
Copy or Delete an Object(s) Select the object(s), then press (<Ctrl>+C)

 or Del key
Fit View To Screen Press F6 function key
Zoom In/Out Press F7/F8 function key
Undo a task Press Ctrl Z keys

Panning the Schematic

There are two ways to move or pan the schematic.

• Point at an empty area of the schematic. Press and hold
the left mouse button until the cursor changes to the pan
cursor, which looks like a four-way arrow.

• Move the mouse while holding the left mouse button
down.

• Release the button when you are finished panning.

• Or, press and hold the Shift  key and press any arrow key
( up, down, left or right  on the keypad or regular numeric
pad).

When the mouse arrow changes to a 4-way arrow, you will be able
to drag the schematic around the window. When the mouse arrow
comes to the edge of the window, the schematic window will
begin to continuously pan. Note: if the cursor is near a component
when you press the button, you might select the component
instead of the schematic.

The Pan Cursor

TUTORIAL # 1 - INTRODUCTION TO ICAP/4
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Zooming In, Out, and on a Portion of the Schematic

SpiceNet allows you to view different sections of the schematic
by changing the current zoom level.  Try any of these methods:

• Right click any place on the Sample.DWG schematic.

• From the Pop-up Menu, Choose “Zoom In 2x.”

• From the Options menu, Choose “Zoom In  2x.”

The schematic image is now shown at 2X resolution.

• Use the F6 keyboard function key to “Fit to Page,” F7
to “Zoom In,” and F8 to “Zoom Out.” Note: “Zoom In”
and “Zoom Out” are done with respect to the blinking
insertion point.

• Or, select  the “Zoom Function” from the right side Tool
Palette.

 The mouse cursor arrow becomes a crosshair symbol.

• Point  the mouse, then click and hold the left mouse
button and drag a bounding box around the desired
zoom area.

• When the area has been selected, release the mouse
button. Then, zoom in on the selected area.  When
you’ve finished zooming, press the Escape key to return
to normal cursor mode.

• Close the drawing and do not save changes.

The F6, F7, and
F8 function
keys can also
be used to
change the
zoom level.

Fit To Page

Zoom In

Zoom Out

icon bar

Tool
Palette

 • Press F6 (Fit to Page) to view the entire schematic.

The panning motion will not alter the symbol positions relative
to the page borders or the rulers.
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TUTORIAL # 2 - SPICENET BASICS

Tutorial #2 - SpiceNet Basics

In this tutorial you will learn how to place, delete and select parts
or symbols on a schematic.

Placing Parts

Now that you know how to manipulate a schematic, try placing
some parts. This can be done in one of four ways: from the parts
menu, using hotkeys, part browser, or Parts Bin Window.

Click in an empty area of the schematic. When a part is placed,
SpiceNet will place the part where the square box is blinking.
Then, the box will automatically move so it will be ready for the
next part.

Place passive parts from the Parts menu or use the hotkeys. For
active, behavioral and code models, use the part browser. Note
that the Preferred submenu will expand to show a user-preferred
part list, any recently placed parts, and any parts added to the
Preferred Parts Bin. This Preferred submenu can also be
accessed from the top of the right mouse-click pop up menu.

Use SpiceNet
hot keys to
place parts
quickly.

Parts Browser
icon

To view or edit the
part’s Spice model,
simply click on the
“Edit Model”  button.

• From the Parts menu,
select   Parts Browser or
type “X”.

• Or, click on the Parts
Browser icon.

• Use Find to do a search
of all text fields for
specific text.

• Choose a part.  Click  the
Place button to place
selected part on the
schematic.

• Parts placed from the
Parts Browser will be
added to the clipboard.
Press (<Ctrl>+V) to place
the same part again.

If you place a part and subsequently edit its library
file or symbol, you must use the “Update Cache”
button to use the new model definition and symbol.

Where the symbol and part
netlist is coming from.

To edit an
existing symbol
click on the
“Edit Symbol”
button.

Use the “Add”
and “Remove”
buttons to
generate your
Preferred Parts
List.

Parts are
organized by
Part Types,
Sub Types,
then Part List.
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In the Part Browser dialog, click on the Parts Bin Editor button.
This brings up the editor with the currently selected browser part
available for adding. At the top dropdown, select your Parts Bin
Tab, and in the middle dropdown you will see all the parts in that
selected tab (Parts In Tab). If you want to add the current browser
part into the selected tab, then click on the “Add To Tab” button.
The current browser part will be added to the Parts in Tab
dropdown with the Part Browser Description. If you want to
modify the description shown in the Parts Bin Window, then click
on the “Edit Part Description” button. Finally, click the “Ok”
button to keep all changes. This entire dialog just affects the
tabbed side panel that you can bring up for quick direct part
placement. You will see a graphical representation of the part,
part name, and description of the part you just added.

Deleting Parts

 You can delete a part from the schematic.

• Highlight a part and use the delete key, (<Ctrl>+X)  or
backspace to delete.

• Use (<Ctrl>+Z) to undo.
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TUTORIAL # 2 - SPICENET BASICS

Selecting Parts or Symbols

In order to copy, delete, rotate, flip, label or move a symbol, let’s
review how to select a part or symbol.

• To select a single part, point at the center of the symbol,
then press the left mouse button and briefly hold it until
the part is highlighted.

• To select more than one part symbol, press and hold the
Shift key.  Point at a symbol and click the left mouse
button. Then point at a different symbol and click the
mouse button.

• To select a group of symbols, point the mouse arrow
outside the group of symbols. In one motion, press the
left mouse button and move the mouse.

• As the mouse is moved, a bounding box is created.
Release the mouse button to complete the selection.  All
chosen components will be highlighted.

• To deselect the symbols, click the left mouse button in
a vacant area.

Review:   To select a pan cursor (four arrows), hold down the left
mouse button and try moving the mouse slowly.   Also, you can
use the F6 function key to view the whole schematic on the
screen.
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ICAP/4 can perform unlimited undo  (<Ctrl>+Z), and redo
(<Shift>+<Ctrl>+Z) to operations.

• On the keyboard, hold down (<Ctrl>), press ( Z) to delete
the most recently placed part, or hold  the ( Z ) down to
delete all parts.

• (<Shift>+<Ctrl>+Z) will redo the string of removed parts.

• Or, from the Edit Menu, choose Redo or Undo.

Only Parts
Completely Inside
Bounding Box Will

Be Selected
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Customizing the SpiceNet Toolbar

Many of the functions used for editing a schematic can be
placed on the SpiceNet toolbar to speed up things like deleting,
copying, pasting, moving, rotating or flipping.

The SpiceNet toolbar shipped with the software should look like
this:

Customize the toolbar to fit your preferences.

• From the Options menu, select Customize Toolbar. As
long as this Customize dialog is up, you can edit the
toolbar. The icons are organized into Categories. Click on
a button to see its description at the bottom of the dialog.

• Drag the desired icon from the Customize dialog to the
toolbar, or drag an icon off the toolbar.

• Close the Customize dialog when done.

• From the Options menu, choose Save Preferences.

If you forget to save the changes, the program will remind you
when you close SpiceNet.

Editing a Schematic

A symbol or a group of symbols must be selected for the copy,
paste, delete, move, rotate and flip functions to work.

• From the Sample.DWG schematic, select the Voltage
Source symbol (extreme left) by pointing at the middle
of the symbol and holding down the left mouse button.

• From the Edit Menu select copy, then click in a vacant
spot on the schematic.
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• From the Edit Menu, select paste.

• OR from the keyboard, choose (<Ctrl>+C) to copy, and
(<Ctrl>+V)  to paste in a vacant spot on the schematic.

Both menu and keyboard commands for copy (<Ctrl>+C) and
cut (<Ctrl>+X) store the selected part on the clipboard for later
insertion.  However, the menu clear command and the delete
key on the keyboard does not store the selected object.

To move a symbol:

• Highlight a desired symbol, click and drag the symbol
to a preferred area on the drawing, then release the
mouse button to place the symbol.

To move a group of symbols:

• Click on several symbols while pressing the Shift key.
Then, release the Shift key.

• Place the mouse arrow within one of the symbols’
bounding boxes, then hold down the left mouse button.

• Drag the selected group. Release the mouse button to
place the symbols.

To rotate or flip a symbol or group of symbols:

• Select a symbol or group of symbols. Press the rotate
and flip buttons on the menu bar.  Alternatively you can
press the + key or the - key depending on the desired
action.

The + key  rotates a symbol  or group of symbols 90 degrees
clockwise; the - key flips the symbol or symbols.

• Close the schematic without saving.

Use the
function keys
F7 and F8 to
zoom in and out
relative to the
insertion box;
use F6 to fit the
schematic on
the screen.

Rotate or flip
multiple
selected parts
as a group
about their
collective
center.

Voltage Source
symbol
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Rotate icon
Flip icon
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Wiring and Connecting Parts

Parts are connected by joining two pins together, or by connecting
two pins with a wire. If the diamonds do not disappear, the parts
are NOT connected.

When two parts are connected, the pins disappear and are
replaced with a node number, as shown above.

To connect two parts by joining the pins:

• Place two resistors on the schematic. Press “R,” then
click somewhere else on the schematic and press “R”
again.

• Left mouse click on the middle of one resistor. Hold down
the mouse and drag the resistor by moving it close to the
other until the diamonds overlap and become a dot.

To connect two parts with a wire:

• From the previous step, highlight one resistor, then
drag it off the other resistor.

• Invoke the wire tool by pressing the letter “W,” or
choose the wire button in the tool palette in the upper
right side of the scroll bar.Wire

button
• Point the wire pencil at the left pin on the resistor.   Press

and hold the left mouse button to define the start of the
wire, then move the pencil toward a pin of the other
resistor.

• Release the mouse button to end the wiring process.

Note: A wire can be drawn at any angle by holding down the <Ctrl>
key, pressing the left mouse button and moving the wire pencil.

Connected Not Connected

Right mouse
press and drag
to draw wire at
any angle.

Press <Alt> key
to toggle rubber
banding.
Rubberbanding
is the ability to
move parts
while having the
attached wires
stretch and
remain
connected.

Right mouse
click without
moving to end
wire mode.

R1
1

R2 R1 R2

R1
1 2

R2
12

2 2
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Connecting with Buses
Buses  are wires  used to connect groups of wires or pins, to other
groups of wires or pins. They appear as thick wires on the
schematic.

To draw a bus:

• From the Parts menu select Bus, or press the 2 and W keys.

• Point to the desired starting point, press and hold down
the left mouse button, and draw a vertical bus that is
about 1” long.

• Release the mouse button to end the segment.

Bus Rules
Buses may pass through wires, parts, pins or breakouts from
other buses without making a connection. Buses may pass
through other buses without making a connection when the end
of each bus does not touch. If the ends touch, a connection is
made as long as the buses are compatible.

Buses may be drawn orthogonally or at any angle. Although
buses may not be stretched or re-sized, they  may be  placed end-
to-end in order to create a continuous bus. In such a case, the
two buses join to become one continuous bus, and both will have
the same name.

Non-orthogonal buses, which are placed end-to-end, will join to
form a continuous bus. This is also the case when an orthogonal
bus is placed end-to-end with a non-orthogonal bus.

• Double-click on the Bus you’ve just drawn.

To draw a bus
at any angle,
hold down the
<Ctrl> key while
drawing the
bus.

Note: Labels for
non-orthogonal
buses (or wires)
can not be
displayed on
the schematic.

The bus properties dialog opens.  This enables the user to add
nodes (breakouts), or sub-buses to the bus. Let’s add an 8-pin
breakout to the bus.

TUTORIAL # 2 - SPICENET BASICS
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• Click on the “Bus1” name in the Bus  Properties
dialog.

• Click on the “>>Add>>” button, then click on the
“Make Breakout” button.

The 8-pin breakout has been added to the bus.

• The Bus window then closes.

• Press the Delete key to remove the highlighted
buses.

• Click on the “Add to Bus...” button and enter a
value of “8” in the Add field, then click the OK
button.

Bus with an 8-
pin breakout.
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Adding and Deleting Multiple Pages of Schematics

SpiceNet can edit multiple schematics and multiple pages of a
single schematic at the same time. You can cut and paste
between different schematics, and use previous designs in your
current drawing. Dividing one schematic into multiple pages  is
not recommended, unless the schematic is very large.

To create one or more additional pages for a design:

• From the Options menu
choose Pages/Edit.  A dialog
shown on the left will pop
up.

• Click on the New button, then
OK to add a new page

• Or, you could have clicked
the Delete button to delete a
page.

SpiceNet will automatically assign a name, e.g., “Page 2.”  If
you later decide to switch page numbers around, then click on
the Renumber button. To activate a desired page in SpiceNet,
the page must be highlighted.

To copy and paste or navigate between multiple
schematics:

• From the File menu,  choose Open, then navigate to a
new schematic.

• From the Windows menu,  choose Cascade, Tile
Horizontal, or Tile Vertical.

• Or, select the Tiling option you want from the icons
on the Toolbar (horizontal or vertical rectangles).

Schematics
can be tiled in
three ways:

horizontally

vertically

 or with
cascading
windows.
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Note: You will be reminded that this deletion of layers is
permanent and can’t be reversed by the undo command.

Working with Multiple Layers

SpiceNet is a layered (US Gov’t. Patent No. US 6,230,305 B1)
hierarchical schematic system, enabling different parts of the
circuit to be placed on different drawing layers. Artwork and notes
can be added to any layer. All layers are easily wired together
since all layers are visible at the top level. The simulation is run
on the culminated netlist.

:\spice8\SN\sample2\Sample.DWG is an example of a schematic
using multiple layers flattened together into different
configurations. For example, one can measure the Open and
Closed Loop characteristics of a part by choosing which test
circuitry (configuration) respectively employs that part.

To add, rename or delete a layer:

• From the Options menu,  choose Layers.  To activate  a
layer, open the active layer pull down menu.

         

• To add a new layer, select New.  A name is automatically
generated.

• To rename a layer, type the new name in the box, then
click OK.

• To delete a layer, click the Delete button and OK.



31

VCC
5

16

15

R12
5k

R13
120

14
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To see the two layers in the current Sample.DWG: This is
a closed loop configuration.
                 

• Hold the left mouse button over the eye in the lower
left hand corner of the schematic.  The circuitry
placed in layer 1 is now highlighted.

• Open the drop down list to the left of the eye to see all
layers in this schematic.  Scroll to layer 4.

• Press and hold the eye in the lower left hand corner
of the schematic. The section of the total design
placed in layer 4 is now highlighted.

To move parts from one layer to another:

• Select the parts individually or in a group by holding
down the Shift key while selecting them.

•      From the Edit menu, select Move to Layer

         

Labeling Parts and Changing Values

Attributes such as value, node number, passed parameters and
reference designations for each symbol are accessed through
the Part Properties dialog, or the NetList editor.

• Double-click on the resistor R13 in Sample.DWG, type
“120” into the Value field. Scroll down the parameter list
to see all of the available model parameters.

Select all the
parts you want
to move to
another layer,
right mouse
click, select
Move Item to
Layer and
choose a
specific layer.
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• Click on the Next Part or Prev Part button.

Each part symbol in the schematic is highlighted as the button
is pressed. This feature allows you to enter all of the part values
and place all of the labels without leaving the Properties dialog.
You may have to move the Properties dialog, depending on
your screen size, in order to see the highlighted part.

•   Return to R13 in the box toward the right side of the dialog.

•   Click on Split label style button just below.

• Or, Click on the “Wide” Label style button to display  the
label in “Wide” mode.

• Click on the OK button to close the properties dialog for
the resistor. Notice that the value is now 120.

•  Click on the R13 label on the schematic and use the “+” key
to rotate the label 90 degrees clockwise.

The Split Label
Style allows you
to position each
part of the label
separately.

Wide Label
Style

Part labels
can be
dragged
and
rotated.

Split Label
Style

You can move a label independently of its associated part, but
if you move the part then all labels will move with it. If you lose
track of which label belongs to its part, just double-click on the
part and the labels belonging to that part will be highlighted.
Alternatively, you can double-click on a label to highlight which
part it belongs to.

R13 100

R13 100 
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Finding Parts and Editing Values Using NetList Editor
To quickly locate parts and nodes in your schematic, use the find
feature.

•  Press (<Ctrl> + F) to bring a Find dialog to view. This
contains all the parts and nodes of the design.  The
node or part will be highlighted in the schematic while
it is selected in the Find dialog.

•  Double click on the highlighted part on the schematic
after the Find dialog is closed.  The Part Properties
dialog will come to view.

• To find the part using the NetList Editor, select the Actions
Menu, then NetList Edit function.

• Select the desired part from the Part list in the upper left
of the dialog, or click the Next Part or Prev Part button to
navigate to the desired part. The part will be automatically
highlighted.

• Click on the “Part Properties...” button to bring up the
Properties dialog for the part that you wish to edit.

Note: When the Properties dialog is dismissed, the NetList Editor
dialog  remains open to permit subsequent operations.

• Click on the OK button to close the NetList Editor dialog.

Control F for
find parts
dialog.

TUTORIAL # 2 - SPICENET BASICS
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• OR double-click on a node
and enter the name in the
Node Name dialog.

• Then click on the OK button.

• Select a node name and
change it.

• Then click on  the OK button.

Renaming Nodes

Node Names are automatically assigned by SpiceNet as nodes
are created.  These names may be changed at any time.

 Rename the nodes as follows:

• Highlight the desired parts and right click.

• Select Node Names  in the pop-up menu.

Note: The
display check
boxes are only
enabled for
node names
that are
alphanumeric
strings or
integers of
more than 3
digits.

Node names that are integers of 3 digits or less, e.g., 1, 22 and
333, are not movable schematic objects, and are always
displayed.

Alternatively, node names changed to alpha or alphanumeric
strings, or integers with more than 3 digits (examples: P1, V123,
VCC, VOUT and 4444) will be displayed and are movable on the
schematic. An check box allows for non display of these names.

   Pop-up menu
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IsSpice4 Control Statements

The control statement for SPICE simulation setup is now examined.
Importantly, the  Analysis Wizard in the Simulation Setup dialog will
walk you through all available analyses and their required parameters.
You may also add or modify a control statement by clicking on the
button with the analysis name (see below).

The User Statements window within the IsSpice4 Simulation
Setup dialog is used to optionally add IsSpice4 control statements
and ICL commands. Any line that is entered into this area of the
dialog will be inserted into the input Netlist.

• Select Simulation Setup/“Edit...” from the Actions menu,
or click on the Simulation Setup icon.

There is a Convergence Wizard that will help you to resolve
simulation convergence problems, if they occur.

• Click on the Convergence
Wizard button to view the dialog.

• Then click on the Finish button.

The
Convergence
Wizard helps
you resolve
simulation
convergence
problems. See
the on-line Help
for more
information.

This is the
preferred
method, as
opposed to
direct netlist
editing, for
adding
statements to
your netlist.

Click on the
Help button for
IsSpice4 syntax
and analysis
control
statement
information.

User Statements
Window

Help Pop-Up Menu

TUTORIAL #2 - SPICENET BASICS
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Entering Multiple Sets of IsSpice4 Control Statements

SpiceNet has the ability to save multiple sets of IsSpice4 control
statements in different simulation setups (Configurations).

A simulation setup configuration consists of a specific set of
IsSpice4 control statements. Any combination of IsSpice4
control statements can be included into each configuration.

Different simulation setup configurations can be used to drive
different simulation scenarios. For example, you might have one
configuration for a “Monte Carlo” analysis, and another for a
Transient analysis.

The configuration methodology alleviates the need for you to edit
IsSpice4 control statements for different analyses or test cases.

• Click on the Edit  button beside the Configuration drop
down list box.

• Then click on the New button.

The default
simulation
setup
configuration is
“Setup1.”

You can type a
test description
here.
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You may enter a name or simply accept the suggested name.

• Click on the OK button to accept the suggested name.

• Click on the Apply button to close the Edit
Configurations dialog.

The IsSpice4 Simulation Setup dialog for the Setup4
configuration is now displayed. It has not yet been configured
with a .AC or .TRAN statement, etc. We won’t configure it for the
purposes of our exercise.

Once multiple simulation configurations have been defined, you
may select the desired one from the drop down list box in the
IsSpice4 Simulation Setup dialog, atop in SpiceNet’s toolbar.

The selected simulation setup configuration will become active
and will be used when the next simulation is performed.

• Click on the Done button to close the IsSpice4
Simulation Setup dialog.

TUTORIAL #2 - SPICENET BASICS
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Inserting Text in the Schematic

Text objects may be inserted directly on the schematic either
from the Text Object in the Parts menu, or using the Text tool in
the Tool Palette.  Bring a schematic to view.

• Left click on the Text tool in the right SpiceNet toolbar.
• Place the mouse cursor in a free space on the

schematic and click. A text box will appear.
• Type the words “Sample Text” in the box.
• Highlight the text.
• Press the Delete key to delete the text.

Note:  By entering text into the Comment box in the Resistor
Properties dialog, text is attached to the symbol and moved with
the symbol.

• Press the Esc key to change back to normal mode or
click any place in the schematic.

• OR Select    in the Tool Palette to return to the normal

mode.

• Press (<Ctrl >+Z) to undo the previous actions.

Text tool

R12
5K
Attached Text
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• Click on the OK button to dismiss the dialog.

A  page border with coordinates now appears on the schematic.

•  Press the F8 function key to zoom out and view the entire
page.

Displaying a Border on a Schematic

• From  the Options menu, select Drawing, Border then
Title Block.  The Border and Title Block dialog will pop up.

A page border and coordinate can  be displayed on a schematic
to easily identify the position of each component on the
schematic

TUTORIAL #2 - SPICENET BASICS

• Check the Show Border and Show Coordinates boxes,
enter the desired Distance From Edge and Line Width
values.
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Adjusting Text Font, Alignment and Schematic’s Color

To modify text fonts:

• Select the “Sample Text” string on the schematic.

• From the Options menu, select the font.

• Select a desired font style and click on the OK button.

To modify text alignment:

• From the Options menu, select Artwork, Text Justification,
and make a selection.
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For information
about the
Global Colors
or Drawing Item
Colors dialog,
press the Help
button in the
lower right-hand
corner.

Changing Color Settings on the Schematic

To change the color of grid dots or selected and
highlighted items on the schematic:

• Choose Options menu, Global Colors.

TUTORIAL #2 - SPICENET BASICS

To change the color of  parts, wires, labels and art:

• Choose Options menu, Drawing Item Colors.
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Working With Parent Colors

Objects on a schematic inherit their colors in the form of a
hierarchy: Drawing, Page, Layer and Item.

• From the Options menu, choose Drawing Item Colors
and a dialog will pop up as shown.

The “Use Parent Characteristics” check box causes the
object characteristics to reset to those of the parent.

If  “Apply to Layer” button atop is selected and the “Use Page
Characteristics” box is checked, then the items that are selected
by the current tab on the current layer will have their characteristics
set to those defined for the entire page. If “Apply to Page” is
selected and the “Use Drawing Characteristics” box is checked,
then the items that are selected by the current tab on the current
page will have their characteristics set to those defined for the
entire drawing.

Checking the “Use Parent Characteristics” check box will not
directly affect changes that may have been made previously at
a lower level in the schematic hierarchy. For example, specifying
the layer to use the page’s characteristics will not override
characteristics that have been modified for a specific part or wire
on that layer.  However, when the OK button is pressed, and if
changes have been made at a lower level, a dialog will query the
user if those changes should also be discarded.
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Printing Your Schematic

The  Print function under the File menu invokes the schematic
preview mode. The options at the top of the screen can be used
to adjust the size of the schematic on the preview page.

•  From the File menu, select the Print function.

If the page you are printing to is smaller than the drawing page
size then multiple pages will be printed.

• Click on the Copy to Clipboard button to place an image
on the clipboard for pasting into another application.

•  Hold the SHIFT key and click on Copy to Clipboard to
choose the type of MetaFile to place on the clipboard
or save the image as an EMF (Enhanced MetaFile).

The Setup button will change the paper size, source, orientation
and margins. Click either print or setup to change the printer.

Note: If you plan to reduce the schematic image for placement
in a publication, then you will want to choose Minimum Printing
Line Width from the Options > Drawing Menu. Enter a larger
number to increase the line width. In this way, no lines will
disappear when the image is shrunk. This setting will only affect
the printed image and the image copied to the clipboard from
print preview. You can copy and paste a small section of your
circuitry directly from SpiceNet to another application, such as
Microsoft Word, but Minimum Printing Line Width does not apply.

Note: Check
the Print Color
box when you
print filled
objects. This
box affects
printing, but not
viewing.
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Drawing Artwork Shapes on the Schematic

SpiceNet provides drawing tools to construct common artwork
shapes on the schematic. Shapes include line, bezier, polyline,
rectangle, round rectangle, ellipse, and polygon. They are
located directly above the vertical scrolling bar.

Holding down the <Shift> key to constrain artwork shapes has
the following affect:

• Lines are constrained to angles of 0, 45, 90, 135, 180 and 225
degrees. This is applicable for lines, poly-lines, polygons,
and base lines for Bezier curves.

• Rectangles, rounded rectangles and ellipses are initially
constrained to squares, rounded squares and circles
respectively, in both the main window and the Symbol Editor.
Re-sizing after an initial draw constrains the artwork to the
last drawn ratio. For instance, if a rectangle is drawn with
length twice the height while re-sizing by holding down shift
key, the rectangle will keep this ratio and not become a
square.

Control the line width of your artwork shape by selecting Line
Width... from the Options, Artwork menu. You can increase the
width up till 19 points. If no artwork is selected, this becomes the
default width. If an artwork is selected then only that artwork’s
line width will be changed.

line

bezier

polyline

rectangle

round rect

ellipse

polygon
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Select Arrow Heads... from the
Options, Artwork menu to add
an arrow head(s) to your lines.
Select an existing line to give it
an arrow head(s), or none to set
the default. This only applies to
line artwork, not poly-lines or
bezier curves.

Select Fill Type... from the
Options, Artwork menu to select
how to fill in your artwork shape.
Colors are chosen in the Drawing
Item Colors... dialog’s artwork
tab.

If you place multiple artwork on top of each other, you can use
“Move to Front” or “Move to Back” in the Edit menu to arrange the
artwork. This only affects the order of artwork on that layer. If you
have multiple layers and you place the artwork on the first layer,
then any circuitry drawn on latter layers will appear on top of the
artwork. Artwork can be moved to any layer desired depending
on the effect you want. You can also rotate and flip artwork like
any other object.

You can group selected artwork and free text labels into a single
symbols. Select the artwork and text labels you want to combine,
then choose Selected Artwork to Symbol... from the Edit menu.

Select the “Bezier line” icon. Then,
hold the left mouse button on the
schematic to drag a line, then
release the mouse. Left click the
mouse once, away from the shape.
Next, hold down the left mouse
button on top of the Bezier line to
highlight it, then release the left
mouse button. Finally, hold the left
button and drag any of the points
on the Bezier line to form a curve.
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Quitting the Tutorial

• From the File menu, select Exit/Quit to end the tutorial.

• Do not save changes.

If you want to save Sample.DWG, from the File menu select
“Save  As” and use a different file name.  This step is
recommended because you  will  use the original Sample.DWG
in  the later sections of this manual.
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Tutorial #3 - Capturing a Schematic for Simulation

In  this tutorial, we’ll capture a schematic, perform a simulation
and examine some waveforms at desired points in the design.

Placing Components

Let’s launch SpiceNet with a new blank schematic:

• Open a new schematic from the <File, New> menu on
SpiceNet’s top toolbar.

• Click on the schematic where you want to place a
component.  An insertion box will appear.

• Type the letter V (it is not case sensitive) to draw a voltage
source symbol, or select the Voltage Source from the
Parts pulldown menu.

V1 is the Spice Reference Description for the voltage source.
This can be changed at any time.

• Type the letter O (not the number zero) to draw a ground
symbol.

Note:  Resistors, capacitors, inductors, etc. may be placed using
hot keys, e.g. R, C, and L, or by using the Parts pulldown menus.

TUTORIAL #3 - CAPTURING A SCHEMATIC FOR SIMULATION

V1

V1
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Adding Component Attributes and Electrical Stimulus to Design

Every component has its own set of values loaded into its Part
Properties dialog.

• Double-click on the voltage source to bring up its
properties dialog.

• Click on the AC value field and enter 1.

Note: AC=1 is the recommended value for AC analysis. It
means that AC has a magnitude of 1.

To set up an AC analysis:
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To set up a transient (time-based) analysis:

• Click the “Enter”
button to bring up
Transient
Generators dialog.

•   Select Pulse tab in the Transient Generators dialog.
•   Enter “0” in the Initial Value field.
•   Enter “1” in the Pulsed Value field.
•   Click OK  to close the window.

“ Pulse 0 1”
generates a
pulse stimulus
in the Transient
analysis.

Note:  The values  we entered will appear in the NetList
Preview  field in the Properties  dialog once  the Transient
Generator window  is closed.

Tran  Generators
is used to
configure Time
Domain Stimuli.

TUTORIAL #3 - CAPTURING A SCHEMATIC FOR SIMULATION

•  Click on the Tran
Generators value
field.
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If you have any trouble with setting up voltage source  properties,
help files can always be launched. There are two ways to get
help:

• Click on the
Property Help
button in the
Voltage Source
Properties dialog.

The help  window is shown below. Different types of analyses
are listed in the window. Click on any phrase for a full explanation
of that particular topic.
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While editing the properties in the Transient Generator
dialog, you may also get help without switching windows.

All of the PULSE
parameters are
defined here.

This field shows
the IsSpice4
syntax for the
PULSE
statement.

• Click on  the
“Help” button  on
the bottom of the
Transient
Generators dialog
to open  the
Help window seen
on the left.

The help information
will be on the topic
that displays on the
tab selected ( in this
case, it is Pulse )
in  the Transient
Generators dialog.

•    Click  on the up-left corner to close the

help window.

•    Click OK button to exit the Voltage Source
Properties dialog.

TUTORIAL #3 - CAPTURING A SCHEMATIC FOR SIMULATION
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Now that we’ve placed and defined the voltage source,
let’s capture the rest of a simple RLC circuit.

• Point to the positive pin of the voltage source
and click the left mouse button to place the
insertion box.

• Type “RLC+O” (the letters R, then L, then C,
then the + key, then the letter O) to place a
resistor, inductor, capacitor  and ground
symbol.

• Double-click on the resistor and enter a value of
“1K” in its Value field, then click on the Next
Part button.

• Enter a value of “100U” in L1’s Value field, then
click on the Next Part button.

• Enter a value of “30P” in C1’s Value field, then
click on the OK button to dismiss the Capacitor
Properties dialog.

The schematic will look like this:

To save the work we’ve done so far:

• Select the Save function from the File menu, or
click on the Save icon, then enter “RLC” in the
“File name” field.

• Click on the Save button.

Notice that SpiceNet’s title bar has changed:

Node 0 is
defined as
system ground
in all IsSpice4
netlists.

Use the “+” key
to rotate parts
90 degrees
clockwise.

Save icon

The Save
icon is
enabled
when a
change is
made to the
schematic.

1 2 3
R1 1K L1 100U 

V1
C1
30P
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Test Point Symbols

Test points are used to generate real-time waveforms (via VIEW
and ALIAS statements). These statements cause the IsSpice4
simulator to calculate waveform data at the test point locations,
and display it in the real-time waveform display.  This will be
covered a little later in this chapter.

There are five basic test point symbols available:
Y:  node voltage (referenced to ground)
2Y: differential voltage
3Y: device current (placed within the body of a part)
4Y: device power (placed within the body of a part)
6Y: current subcircuit (placed on subcircuit pin)

Note:  When placing a test point on a part, a red dot indicates
connectivity.

• Click on node 3 (the output) and type the letter Y to place
a voltage test point on that node.

• Double-click on the test point and enter “Voutput” in its
Name field, then click on the OK button.

• Click on the body of R1 and input “3Y+++” (the number
3,  letter Y, and 3“+”s) to place a current test point on R1.

• Double-click on the current test point and enter “Iinput”
in its Name field, then click on the OK button.

When the simulation is run, the waveform data for the test points
will be calculated and available for viewing in IntuScope.

Test Point
Symbols

Notes: Power
test points are
not supported in
AC analysis.

Current and
Power test
points do not
support
subcircuit
elements
(reference
designators that
begin with an
“X”). Use
current
subcircuit (6Y)
to measure
current going
into subcircuit
pin.

TUTORIAL #3 - CAPTURING A SCHEMATIC FOR SIMULATION
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Automatic Test Point Ref Des Assignment
Test Point Reference Designation (Ref Des) is automatically
assigned on initial placement based on the following rules:

a) When adding a voltage test point to a named node (i.e., a node
with a name rather than a number), the test point's
Ref Des is set to the name of the node, if the name starts with
the letter "V." If not, it is set to the name, but with a "V" prefix.

b) If the node is unnamed, the Ref Des is set to "V<n>", where
<n> is the node number.

c) When adding a differential voltage test point, its Ref Des is set
to the names of its two nodes as defined in a) and b) above, and
separated by an underscore character. If the second pin of the
test point is not yet connected when the test point is placed,
the underscore character is still appended to the name of the
first node.

d) When adding a current or power test point to a part, the test
point's Ref Des is set to a name that reflects the part for which
it is connected (i.e., "WR1" for a power test point connected to resistor
"R1," "IR1" for a current test point connected to R1, and "IX1_1" for
a subcircuit current test point connected to pin 1 of X1)

e) If a test point is placed where it is not connected to anything,
it is given a Ref Des consisting of the letter "Y," followed by a
sequentially assigned number.

At any time, you can press the "Auto Ref Des" button in Test
Point Properties dialog to rename any test point according to the
above rules, based on its type and current connection(s).

Ref Des is retained
A part and test point’s Ref Des is retained when copying and
pasting, as long as the prior Ref Des does not already exist on
the target drawing. A Ref Des that has been modified to a non-
standard form is also retained with one or more 'x' characters
appended to its copied one, to distinguish it from the original. This
allows you to copy and paste entire sections of circuitry onto
another schematic drawing without losing their assigned part
name and test point name.
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Reassign Ref Des
At any time you can systematically renumber any or all of a
schematic's part reference designations using the following
steps.

• Select "Reassign RefDes..." from the Edit menu.

• If "All Types" is selected, you can begin sequentially
renumbering each type of part starting from 1, e.g., R1, C1,
X1, etc.

• If a specific part type is selected, you have the ability to start
renumbering based on the first part of that type that is clicked.
This means if you click on R7, then the next resistor you
clicked will be renumbered R8.

When a part is renumbered, it is highlighted so the user can
remember which parts have been renumbered and which ones
have not. If you make an error, you can undo the renumbering
by pressing (<Ctrl>+Z) or selecting undo from the Edit menu.

If you modify a part with a
test point connected to it,
remember to double click
on the test point. Then
select the “Auto Ref Des”
button to update the test
point Ref Des based on
the new part name.

This example RLC circuit shows you the ease of schematic
capture. Your parts and test points are automatically assigned
intelligent names. Part names are incremented after each
placement, and test points are named based on their type and
connection(s). You can re-use circuitry from other schematics,
or copy, paste and flip mirror-image circuitry. If such copying
and pasting of existing circuitry causes your circuitry names to
appear messy, you can easily and systematically reassign
them.
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Entering IsSpice4 Control Statements

So far, we have taken care of all but one of the items necessary
for generating an IsSpice4 simulation. We finally need to tell
Ispice4 what analyses to perform.

• From the Actions Menu, select Simulation Setup, Edit,
or click on the Simulation Setup icon.

This dialog is used to generate the analysis statements, which
will be automatically included in the IsSpice4 netlist and used
to drive the simulator.

This dialog
contains
simulation
control
buttons.

Simulation
Setup icon

Click on the
Help button for
information on
the analysis
setup.
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In addition to the in-application Help available in this dialog, there
are also two powerful wizards that will help you generate
simulation control information quickly and accurately. We
introduced you to the Convergence Wizard in the SpiceNet
Basics Tutorial. Let’s take a look at the Analysis Wizard.

• Click on the Analysis Wizard button.

Now let’s create the control statement automatically for a
Transient (time domain) simulation for the  RLC circuit.

• Click on the “Transient - Nonlinear Time Domain
Analysis” radio button and then click on the Next
button.

• Enter a value of “5n” for the Data Printout Step (Tstep).

The Analysis
Wizard
automatically
creates the
simulation
control
information.
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• Then click on the Next button.

• Enter a value of “1u” for the Total Analysis Time
(Tstop).

• Then click on the Next button.

• Leave the “No” radio button checked. This is the
default mode.

• Click on the “Finish” button to complete the operation
and exit the Analysis Wizard.

Tstop specifies
the time length
of the
simulation.

Tstep is the
time interval
(sampling rate)
for which
interpolated
data will be
recorded and
placed in the
output file.

Tstep must be
small enough to
resolve the
highest
frequencies in
the circuit.
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The “.TRAN 5n 1u” statement tells IsSpice4 to perform a time
domain analysis when the simulation is launched. The simulation
will begin at 0 seconds and end at 1 microsecond. Calculated
data points will be written to the output file at 5 nanosecond
intervals.

The Analysis Wizard has created the Transient statement for
you, and has also checked the box beside the Transient button
so that it will be performed when the simulation is launched.

The Analysis
Wizard has just
created the
IsSpice4
Transient
Analysis
statement
for you.

Help Pop-Up Menu

Final ISSPICE4 Statement

User Statements
WindowYou may enter

any ISSPICE4
statements in
this window.

TUTORIAL #3 - CAPTURING A SCHEMATIC FOR SIMULATION

ISSPICE4 Help Syntax

You can
directly edit the
Transient
Analysis
statement by
clicking here.
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As you become more familiar with the different types of simulation
analyses, you may select the desired analysis function and
enter the simulation parameters yourself.

• Click on the “Transient...” button in the IsSpice4
Simulation Setup dialog.

Notice that the “Data Step Time” and “Total Analysis Time”
fields already contain data (i.e., 5n and 1u, respectively). The
Analysis Wizard enters the information for you. If you want to
change the simulation parameters for this analysis, you may
change them here or revisit the Analysis Wizard.

Next, let’s specify the simulation control information, which will
be used to perform our AC analysis of the RLC circuit.

• Click on the OK button to dismiss the dialog.

We could use the Analysis Wizard to create the control
information for the AC analysis, just as we did for the Transient
analysis.

See the in-
application Help
for more
information
concerning the
Transient
analysis by
clicking on the
Help button.
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Alternatively, let’s enter the data directly in the AC analysis
dialog within the IsSpice4 Simulation Setup dialog.

• Click on the “AC Analysis...” button in the IsSpice4
Simulation Setup dialog.

• Enter “10” for the No. of Points.

• Click on the “Decade” button.

• Enter “10K” for the Starting Frequency value.

• Enter “100MEG” for the Ending Frequency value.

• Click on the OK button to close the AC Analysis dialog.

The AC
analysis is a
linear analysis
that sweeps the
circuit response
through a range
of frequencies.

See the on-line
Help for more
information
concerning AC
analysis.
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The AC
Analysis box
has been
checked
(activated)
automatically.

This is the
IsSpice4 AC
Analysis
statement we
just created.
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The “AC DEC 10 10K 100MEG” statement defines an AC
frequency sweep that collects 10 data points per decade. The
starting frequency is 10KHz, and the ending frequency is
100MHz.

We’ve just finished specifying the second of two control
statements that will be used in the simulation. We’re now ready
to run both a Transient analysis and an AC analysis.

Notice that there are “check marks” in the check boxes beside
the Transient and AC analysis buttons. This indicates that
those analyses have been specified and activated.

You can activate and deactivate simulation options by checking
or un-checking their boxes.

• Click on the Done button to close the IsSpice4
Simulation Setup dialog.
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Running a Simulation

At this point, we have captured the RLC schematic and entered
all of the required information.

When the simulation is performed, all applicable node voltage,
device current and power dissipation data is saved by default.
Device current and power measurements are accessed through
the Device Properties dialog.  Default power measurement is
turned off for capacitors and inductors.

Now let's run the simulation.

• Select Simulate (<Ctrl>+G) from the Actions menu, or
press the Simulate (running man) icon in the top toolbar.

The IsSpice4 simulation screen appears and the simulation is
performed. The RLC circuit waveforms at the test points, i.e.,
Voutput and Iinput, are drawn in the real-time waveform display
as they’re calculated. You can see the waveforms for both the
AC and Transient analyses.

Note: The real time waveform viewer provides a thumbnail
sketch. Detailed waveform views are provided in IntuScope
(covered later).

You can also
click on the Run
Simulation icon
in the toolbar
to launch the
simulation.
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The IsSpice4
simulator, and
how to use it
interactively,
are covered in
the next tutorial.

Important Note: Do NOT quit the IsSpice4 simulation (e.g.,
don’t close the window out). It must remain open while we
cross probe waveforms in the next section.

An After Simulation dialog will be displayed after a simulation is
run. It has three radio buttons providing the choices: "Switch to
SpiceNet After Each Simulation," "Switch to IntuScope After
Each Simulation" or "Remain in IsSpice After Each Simulation."
There is also a check box for "Show This Dialog After Each
Simulation." This allows you to specify which program immediately
becomes active following a simulation, based on what you are
trying to accomplish. If you do a lot of cross-probing, create
simple curve families (e.g., alter function), or run scripts placed
on your schematic, then select “Switch to SpiceNet After Each
Simulation.” If you do a lot of waveform measurement, then
select “Switch to IntuScope After Each Simulation.” If you want
to quickly tweak any circuit parameter and see your real-time test
point waveforms be instantly updated, then select “Remain in
IsSpice After Each Simulation.”.

In IsSpice4, select “After
Simulation Go To...” in the
Options menu. If desired,
select another choice for the
active window. Save
preferences only saves
window position and size.
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Cross Probing on the Schematic

ICAP/4 has the ability to interactively display node voltages,
device currents and power dissipation directly on the schematic,
and in the IntuScope waveform viewer. To display a waveform
on the schematic, simply set the desired mode in the Actions/
Cross Probe menu, hold the SHIFT key  and then click on the
appropriate schematic node or device. Alternatively, right mouse
click on the appropriate schematic node or device, hold the
SHIFT key and then select the cross probe mode.

• From the IsSpice4 window, select Actions menu,
Schematic  to switch back to the schematic so we can
perform the cross probing.

• Select Probe  in the Actions menu, or click on the Probe
icon to activate the cross probing tool.

Cross Probing a Voltage
To view a voltage, simply hold down the SHIFT key and click on
the desired node or test point.

Let’s display the voltage at the output of the circuit. Notice that
the mouse arrow has changed to a probe symbol.

• Click on the test point, “Voutput” with the probe tool
while holding down the SHIFT key.

The voltage waveform appears on the schematic.

• Move the Cross Probe cursor over the Vout schematic
waveform. It will automatically change to the normal
cursor. Drag and drop the Vout waveform out of the
way to cross probe some more waveforms.

The analysis type
and voltage/
current or power
setting are
changed via
Cross Probe in
the Actions menu
or the Cross
Probe right
mouse button
menu.
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VOUT

Tran

1.48

-70.7M
1.00U0 time

Voutput test
point voltage

The normal
cursor allows you
to move, re-size,
and delete
schematic
waveforms. The
Cross Probe
cursor changes
to the normal
cursor when it is
over a schematic
waveform.
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Cross Probing a Device Current
To view a device current, simply click on the device symbol while
holding down the SHIFT key.

Let’s display the current through resistor R1.

• Click on the resistor, R1, with the cross probe tool  while
holding down the SHIFT key

The current waveform appears on the schematic.

Similarly, you may move the waveform out of the way and then
cross-probe the current through L1 and C1.

As you recall, we ran both a Transient analysis and an AC
analysis. The active analysis type, Tran, is shown in the Cross
Probe menu item under the Actions menu.

Cross Probing an AC node voltage
To view an AC voltage, simply set “Actions, Cross Probe”  to AC
mode, then click on the node with the probe tool while holding
down the SHIFT key.

Let’s change the probe analysis type to AC and take a look at the
AC magnitude response at the output of the RLC circuit.

• Select the AC mode in the Cross Probe function under
the Actions menu.

• Move the R1 Current waveform out of the way, if necessary.
Then click on node 3 with the cross probe tool while
holding down the SHIFT key.

The AC magnitude waveform for node 3 is displayed, as shown
on the next page.

NOTE:  It will
stay in AC
Voltage/Current
Cross Probe
mode until you
change it.

IINPUT

Tran

404U

-184U
1.00U0 time

Current through R1

To change
Cross Probe
mode and plot
the schematic
waveform at the
same time, you
can right mouse
click on node 3,
hold the SHIFT
key down, and
select AC
Voltage/
Current.
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Cross Probing Device Power Dissipation
To view the power dissipation through a device, simply set the
cross probe mode to Tran and Power in the “Actions, Cross
Probe” menu.

Now let’s display the power dissipation through R1.

• In the Actions menu, select  Cross Probe  and the Tran
and Power options.

• Move the V(3) waveform out of the way, if necessary.
Then click on the resistor, R1, with the probe tool while
holding down the SHIFT key.

The power through R1 is displayed.

NOTE:  Cross-
probing does
not support
subcircuit
elements
(reference
designators that
begin with an
“X”). To make
subcircuit
instance
parameters
available in
IntuScope’s
Add Waveform
dialog , go to
IsSpice4’s
Simulation
Setup dialog
and check Save
Data, Save all
node voltages,
Save all device
currents and
Save all power
dissipations.

@R1[P]

Tran

149U

-7.10U
1.00U0 time

VOUT
in dB 

AC

8.75

-64.8
frequency
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AC voltage at node 3,
Voutput

Power through R1

• Press the Esc key or right mouse click and choose
Normal Cursor to end Cross Probing.



68

Power
waveforms
can only be
viewed in the
Transient
analysis.

Note:
Resistor
power
waveforms
are saved by
default. Look
in the Part
Properties
dialog to see
the saved
device
waveforms.

Resistor power waveforms are saved by default. To see if a part’s
current or power waveform will be saved, look in the parameter
list in its Properties dialog, e.g., “i current” and “p power.” A “yes”
entry indicates that it will be saved, so that it is available for
viewing. If a device’s current or power option is turned off (e.g.,
the entry is “no”) you may turn it on by clicking “no” to open the
data field, then selecting the “yes” option.
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Cross Probing to IntuScope

Just as we cross probed to display node voltage, device current
and power dissipation waveforms on the schematic, we may
also cross probe waveforms to an IntuScope graph. Cross
probing to IntuScope is the same as cross probing to the
schematic except you no longer hold down the SHIFT key while
cross probing.

If IntuScope is not currently running it will automatically launch
in the background when you try to cross probe to it.

• Move the R1 power waveform out of the way, if
necessary. Then click on R1 with the probe tool.

This will send the R1 power waveform directly to IntuScope
instead of plotting it on the schematic. If you right mouse click
on R1 while in cross-probe mode, you can choose to send either
the current or power waveform to IntuScope. Note that once you
change to cross probe mode it will stay in that mode until you
change it again.

• Select “Scope” from the Actions menu or toolbar
icons to view the waveform in IntuScope.

IntuScope
functions are
discussed in
Tutorial 4.

This is the
IntuScope
graph window,
which now
displays the
power through
R1.
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Next, let’s display the AC waveform at the output, node 3. Since
the Transient waveform has a linear time scale, and the AC
waveform(s) will have a semi-log scale, we’ll open a new
waveform graph in IntuScope.

• Select New Graph from the File Menu in IntuScope.

• Select Schematic from the Actions menu to go back to
the schematic, or press its box at the bottom desktop.

• In the SpiceNet Actions/Cross Probe menu, select the
AC and  the Voltage/Current mode.

• Click on node 3 with the probe tool.

• Select the “Scope” option from the Actions menu to
view the waveform in IntuScope.

Notice that the AC magnitude AND phase waveforms are
displayed on the graph when you cross-probe a waveform
during the AC analysis.

1 vph(3) 2 vdb(3)
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AC phase
and
magnitude
response of
the RLC
circuit.

Do this in one
step by right
mouse click on
node 3 with the
cross probe tool
and select AC
Voltage/Current
from the
menu.
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Running a Parametric Sweep

Key circuit parameters can be varied directly from the schematic
environment, without having to restart the IsSpice4 simulator.

Once an initial simulation run has been performed, the Alter
function enables you to automatically step a component value or
its temperature, or design temperature, through a prescribed range,
and automatically run a series of simulations. You can choose a
linear or logarithmic sweep of the variation. You can select one or
more design nodes or components to be plotted in IntuScope. The
Alter function creates curve families quickly and easily.

In anticipation of the transient curve family that we’ll generate as
we sweep the value of R1, let’s create a new waveform graph in
IntuScope so the curve family will be easier to view.

• Select New Graph from the File Menu in IntuScope.

• Select Schematic from IntuScope’s Actions menu to go
back to SpiceNet.

Now we’re ready to open the Alter dialog and set up the sweep.
We’ll sweep the value of resistor R1 from 1kW to 10kW, in 1kW
increments, and display the voltage at node 3 (the output node)
each time we change the value.

• Press the Esc key or select the Normal icon from the
right toolbar to exit cross probe mode. Now go back to
normal cursor mode.

• Select  Alter from the Actions menu, or click on the Alter
icon on the right toolbar.

Notice that the mouse arrow cursor has changed to Alter’s
magnifying glass symbol.

• Click on resistor R1 with the Alter tool.

The Alter
function
allows you
to create
curve
families
quickly
and easily.

The Alter
function may
also be used to
change
component
values within
hierarchical
drawings.

Normal
cursor
mode.
You may
also use
this button
to go back
to normal
mode.
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• Click on the Linear button in the “Alter for R1 resistance”
dialog to setup a linear sweep. (Warning: Never enter a
value of zero, notably if the log button is selected)

• Enter a Start value of “1k,” a Stop value of “10k,” then
a Step value of “1k.”

• Make sure that the “default: time” option is selected
under the X Axis field.

• Scroll down the list below the Y Axis field and select the
“V(3)” entry in order to plot the RLC output at node 3.

• Click on the “Add to Plot List” button to add the “V(3)”
entry to the Plot List at the bottom of the dialog.

• Click on the Run button to execute the simulation
sweep.  Dismiss the Alter dialog using the Done button.

Waveforms that
will be plotted

The Alter dialog
allows sweeps
of component
parameters.

Select the type of
sweep and enter
the values

Select the
waveform(s) and
click on the Add
button

Alter Steps:

Select the
analysis type
and then select
the X and Y axis
settings

Sweep value
definition

Analysis type

Waveform definition

Click on the Run
button
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Note: When you’re using the Alter function, you may only select
an analysis that you’ve performed.

• Click OK to close the Alter dialog, then select the “Scope”
function from SpiceNet’s Actions menu or top toolbar.
Notice the curve family in IntuScope as shown below.

• Bring the schematic back to view, then press the Esc key
to go back to normal cursor mode.

IntuScope
functions are
discussed in
the IntuScope
tutorial.

This curve
family was
generated
automatically as
the value of R1
was swept.

All Y Axes can
be scaled and
linked.

This will sweep
the value of R1
from 1KW to
10KW  in 1KW
increments, and
display a curve
family in
IntuScope.

Other more complex
sweeps can be
performed directly in
IsSpice4
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Running a Temperature Sweep

Next, we’ll perform a temperature sweep for this circuit and
look at the curve family output waveforms. In short, to
perform a sweep through a range of circuit temperatures,
simply click on an empty area of the schematic with the Alter
tool. Then, proceed with the usual steps to sweep the design’s
temperature.

However, since there are no active parts (i.e., transistor,
MOSFET) in our schematic example, and therefore the circuit
is not very temperature sensitive, let’s make the results more
interesting. Let’s change the value of R1 so that it’s a function
of temperature.

• Double-click on Resistor R1.

• Then type the following equation into its value field:
R=1K+1K*(1+30m*(TEMP)+2m*(TEMP)^2)

• Click on the OK button to close the Properties dialog.

• Run a simulation.

You can enter
an equation in
the Value field
for any resistor,
inductor, or
capacitor.
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This will sweep
the circuit
temperature from
10 degrees
Celsius  to 50
degrees Celsius,
in increments of 5
degrees Celsius,
and display a
curve family in
IntuScope.

TUTORIAL #3 - CAPTURING A SCHEMATIC FOR SIMULATION

Notice the title
“Alter  for
Circuit
Temperature”.

• Activate the Alter tool.  Then click on an empty area of the
schematic.

• Change the Sweep Mode to Linear.  Enter the values 10
for start, 50 for stop and 5 for step, as shown.

• Add to Plot List the node voltage v(3) for the Y axis.

• Then click on the Run button in order to execute the
simulation sweep.

The resulting curve family is displayed.
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Schematic Layers

Let’s enhance our RLC circuit to create a more practical
example.

The parts we’ve placed so far have been on Layer 1, which is
the default layer. We’ll create a new layer, Layer 2, and place
two active devices (e.g. BJTs), a subcircuit device (e.g., WIRE)
and some additional parts on that layer. Once we have added
the new parts to the new layer of the schematic, we’ll briefly
discuss the topic of “configurations.”

To create a new layer;

• Select Layers from the Options menu in SpiceNet.

• Click on the New button.

• Type “Layer 2” into the “New Layer Name:” field.

• Click on the OK button to close the New Layer dialog.

• Click on the OK button to close the Layers dialog.

You may create
a schematic
that has
multiple layers.
All layers are
superimposed
to create the
complete
design.

See the
“Working with
Schematic
Layers” section
in the on-line
help for more
information
about
schematic
layers.
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Now we’ll add a Darlington PNP-NPN configuration with a long
transmission line and a capacitive load to our new Layer 2.

• Capture the schematic as shown below.

The QN3904 is in the BJTs NPN/Switching category in the
Parts Browser. The QN3906 is in the BJTs PNP/Gen. Purpose
category. The WIRE is in the Interconnects/Generic category.
V2 and V3 are both 10 Volts DC, but notice the polarities.

Your schematic may vary from the one shown above, depending
upon the sequence in which parts are placed and connections
are made. Variations in the node numbers or reference designators
will not affect the simulation results.
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V3 is 10 Volts DC

X1 is a subcircuit part

V2 is -10 Volts DC

This is our
enhanced
schematic.

Use the Parts
Browser to
place Q2 , Q10
and X1.
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Subcircuit Parameters

The X1 WIRE symbol introduces a new concept. Unlike the
active devices, which are IsSpice4 primitive elements (basic
building blocks), the transmission line wire is an IsSpice4
“subcircuit” (collection of IsSpice4 primitive elements that are
grouped in order to emulate a particular device).

Some subcircuits, called “generic subcircuits,” have user-defined
parameters that characterize their behavior. These parameters
appear within curly braces, e.g. {Impedance=???}.

The WIRE device is a generic subcircuit. It can be used to
represent a number of transmission lines just by inserting
different values for the user-defined parameters.

• Double-click on X1, which is the WIRE in the schematic.

• Click on the “???” string (unless already displaying 150)
in the Impedance parameter value field (Z) in the
Subcircuit Properties dialog.

• Replace the ??? string with 150.

WIRE symbol

Notice that the
reference
designator for
the WIRE
device is “X1.”
In IsSpice4, “X”
represents a
subcircuit
device.

These are the
parameters for
the WIRE
device.

We’ll enter the
two parameters
here.

X2
W IRE
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Note: Any occurrence of “???” in the Netlist will abort the
simulation and bring up the Net List Errors dialog with a parts
in trouble list.

• Click on the “???” string (unless already displaying 36)
in the Length parameter value field.

• Replace the ??? string with 36.

Length is the wire length in inches, and Impedance is the
impedance in ohms. We have assigned values that represent a
clip lead model. All user-defined parameters for IsSpice4 symbols
and generic subcircuits are entered in this manner.

• Click on OK to close the Subcircuit Properties dialog.

TUTORIAL #3 - CAPTURING A SCHEMATIC FOR SIMULATION
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Test Configurations

A Test Configuration consists of a specific set of layers. You
may include any combination of existing layers into each
configuration. Each configuration should be thought of as a set
of transparencies that are stacked together. When a netlist is
saved, the stacked set of transparencies, or layers, are combined
(flattened) to form the active design.

Different configurations can be set up to drive different simulation
scenarios. For example, you might dedicate one configuration for
a Monte Carlo analysis and another for a transient analysis. You
may have one configuration containing test circuitry, and another
that omits “non-design” elements for PCB layout.

The configuration feature alleviates the need for you to manage
separate versions of the same overall schematic for different
analyses, test cases or end use (e.g., PCB, mil. standard, etc.).

To create a new test configuration:

• Select the Configurations, Edit  from the Options menu.

Layer 1 contains the original RLC circuit (i.e., V1, R1, L1, C1,
and the “Iinput” and “Voutput” test points). Layer 2 contains all
of the other parts just placed. WF:0 contains the cross-probed
waveforms placed on the schematic.

• Click on the New button.

When a
schematic is
initially
captured, the
default test
configuration
name is
“Config 1”.

These are all of the
existing layers for
the selected
configuration
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• The name “Config 2” is automatically suggested for
you. Click on the OK button to accept it.

If we were to add any additional layers, they would automatically
be added to the currently selected configuration, Config 2.

Config 1 and Config 2 now contain the same layers, i.e., Layer
1, Layer 2, and WF:0, since all layers are selected by default.

To edit a test configuration:

• Click on the “Config 1” configuration and click on the
“Edit...” button.

• Click on the “Layer 2” layer to deselect it, so that only
Layer 1 and WF:0 are selected.

• Click on the OK button to close the Edit Configuration
dialog.

• Click on the OK button to close the Configurations
dialog.

Notice that the parts on Layer 2 don’t appear on the drawing
because Config 1 is selected, which doesn’t have parts in Layer 2.

Let’s run a simulation of Config 1.

When a new
configuration is
created, all
existing
schematic
layers are
automatically
added to it.

As new layers
are created,
they are
automatically
added to the
active
configuration.

TUTORIAL #3 - CAPTURING A SCHEMATIC FOR SIMULATION
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• Select the Simulate function from the Actions menu.

Now, let’s run a simulation of Config 2.

• Point to the Configurations function in the Options
menu and select Config 2.

• Select the Simulate function from the Actions menu.

This is the
simulation of
Config 1, which
only contains
Layer 1 and
WF:0.

This is the
simulation of
Config 2, which
contains Layer
1, WF:0 and
Layer 2.
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Displaying Operating Point Values

ICAP/4 has the ability to display the operating point values of the
circuit directly on the schematic.

• Bring the schematic back to view.

To turn on (display) the OP values on the schematic:

• From the Options menu, Refresh OP values then Options,
Display on Drawing. Then, put a check besides OP
voltages or OP current&power.

• Or in the center of the default toolbar press refresh OP
values, Show OP Volts, and show OP Curr/Pow buttons.

Once the OP values are displayed on the schematic, you can
select and move them, or you may delete them (press the delete
key). The position of all OP labels is remembered between
sessions. If you forget which label belongs to what entity, just
move your cursor over the label and a tool tip will appear
specifying what entity it belongs to.

Voltage labels end with V, Current labels end with A, and Power
labels end with W. Use Options, Drawing, Significant Digits... to
control the number of digits shown in the labels.

The schematic will look similar to this:

You may
relocate (drag)
node labels to
suit your taste.

Note:
Remember to
use Refresh OP
values to update
labels with new
number of
significant
digits, or re-
display deleted
OP labels.

Important:
IsSpice4 must
remain open in
order to obtain
the operating
point values.

Notice that node 2
is 0 Volts because
V1 is initially 0 Volts.

DC operating
point voltages
are displayed at
each node
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• From the Options Menu, select Display and
check or un-check pin numbers, part labels, etc.
to display or make invisible.

• Select Actions, Probe to activate the probe tool.

ICAP/4 also has the ability to display detailed operating
point information for a specific schematic part.

If you want to modify the OP value labels’ display color:

• Select Drawing Item Colors from the Options menu.

• Click on the Labels tab to open it.

• Click on the Set Color button, select OP Value Labels
and select your display color.

• Click on the OK button to dismiss the dialog.

Drawing Item
Colors icon
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When you quit
SpiceNet, it
automatically
closes.  IsEd
and IntuScope
do not close.

You may click
on a node to
see its DC
operating point
value.

You can also
display the
operating point
information for
the other parts
by clicking on
them.

• Select the OP option in the
Actions, Cross Probe menu.

• Select Actions, Probe to activate
the probe tool.

A blank OP dialog box is displayed,
since no part was selected when the
OP function was chosen.

Let’s look at the operating point information for resistor R1.

• Using the OP probe tool, click on R1 to display its
operating point information.

• Press the Esc key to return to normal mode.

• Click on the Done button to close the Operating Point
dialog.

• Select Save from the File menu if you want to save your
work.

TUTORIAL #3 - CAPTURING A SCHEMATIC FOR SIMULATION
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• Select Exit / Quit from the File menu to quit SpiceNet.

This concludes the SpiceNet tutorial. In the next tutorial, we’ll
discuss the basic functions of  the IsSpice4 Simulator.
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Tutorial #4 - ISSPICE4

This tutorial will describe the operation of ISSPICE4. It will cover:

• Starting ISSPICE4
• The ISSPICE4 display
• Real-time waveforms
• The Simulation Control dialog
• The Interactive Command Language (ICL)
• Changing circuit parameters
• Examining data from different simulations

A detailed description of things like menu items, dialog boxes
and specific functionality of IsSpice4, including syntax reference
for IsSpice4 ICL commands, is found in the in-application help
from the SpiceNet or IsSpice4 windows’ help pulldown.

Starting ISSPICE4

Let’s first explore some of the IsSpice4 features by simulating a
simple low-pass filter.

• Open the AKTP2.DWG design under the working SPICE8/
IS/AKTP2 directory.

• Select Simulate from the Actions menu.

ISSPICE4 will load the SPICE netlist and run the designated analysis.
Once the simulation is complete, an output file will be created and
the Simulation Control dialog will be displayed. You may optionally
interact with the simulator by entering command scripts into the
Script window of the Simulation Control dialog.

The ISSPICE4 Display

The ISSPICE4 display contains several different windows: a Real-
Time waveform display, a Simulation Control dialog, an Errors
and Status window, and an Output window.
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After the simulation is complete, a display similar to the one
above will appear. The Real-Time display (in blue) shows the
circuit performance as the simulation runs. The Simulation
Control dialog is used to control the simulation flow interactively
(if desired), and provides access to past simulation data. The
Errors and Status window provides corresponding data about a

THE ISSPICE4 DISPLAY

Real Time Waveform Display
Simulation Control

Dialog

Error and
Status

Window

Output Window

Note: Your
display may be
different.

simulation. The Output window functions similar to a traditional
SPICE output file. It stores data in textural format and is produced
by the simulator.

• You can always rearrange the position of each window, then
select Save Preferences under the Options menu.

Real-Time Waveforms

Initially, the Real-Time waveform display will show the waveforms
(also referred to as vectors) as simulation runs progress.  Such
data is also contained in IsSpice4’s .PRINT and .VIEW
statements, and in Interactive Command Language (ICL)
statements. After the simulation is finished, all print expression
waveform vectors created with the ICL alias and view statements
are displayed.
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.PRINT statements display the magnitude of AC vectors in dB.
Other quantities, such as the real, imaginary and phase parts,
must be displayed using the ICL Alias command. For the AKTP2
circuit, the phase of V(4) is displayed after the simulation, via the
use of the “alias Output_Phase PH(V(4))” statement. Print
expression vectors that are created with the Alias command, are
always displayed after the simulation is finished. Note: Since
the real-time display converts a vector to dB for display, a
statement such as .PRINT AC VDB(node #) will not be

displayed.

You can also add any vector that has been
saved via the ICL save statement to the
Real-Time display. As shown in the netlist,
the save all allcur allpow function has
been used so that all of the voltages,
currents, and device power dissipations
from the circuit will be available for display.

Scaling Waveforms
ISSPICE4 scales the Real-Time waveforms
based on the .OPTIONS parameters
Vscale, Iscale, and Logscale. However,
you can rescale a waveform at any time,
as we’ll see in the next section.

• Double-click on the V_4 waveform.
  Click the Auto button. Select OK.

You can automatically scale all waveforms
simultaneously using the AutoScale
function in the Options menu.

Adding and Deleting Waveforms
Before or after the initial simulation, you
will be able to edit the display by deleting
or adding waveforms.

• Double-click in the blank area underneath the V_4
waveform.

D:\SPICERX\CIRCUITS\TUTORIAL\AKTP2.cir
Setup1

*#save V(3) @C2[i] @C2[p] V(1)...
*#save V(4) @Q1[icc] @Q1[ib] ...
*#save V(6) @R3[i] @R3[p] @V1[i]...
*#save @V3[p] @C1[i] @C1[p]
*#alias V_4  v(4)
*#VIEW  AC V_4
*#VIEW  AC PH_V_4 = phase(V_4)
*#VIEW  DC V_4
*#VIEW  TRAN V_4
.AC DEC 50 100 100K
.PRINT AC VDB(4) OUTPUT_PHASE
.CONTROL
OP
SAVE ALL ALLCUR  ALLPOW
ALIAS OUTPUT_PHASE PH(V(4))*1
.ENDC
.PRINT  AC Vdb(V_4) phase(V_4)
C2 3 0 10N
R1 1 2 10K
Q1 5 3 4 BJTN
.MODEL BJTN NPN
R2 2 3 10K
R3 4 6 10K
V1 5 0 DC=10V
V2 6 0 DC=-10V
V3 1 0 AC=1 PULSE 0 1
C1 2 4 39N
.END
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• Enter V(2) into the “Node” field. Click on
the Auto button and select OK.

V(2) will be displayed. Since the netlist includes
the save all function, we have access to all of the
node voltages. Therefore, any circuit node number
can be entered into the “Node:” field. Note: only
waveforms from the active analysis can be re-
scaled. For example, if a transient analysis is
running, you will not be able to rescale, add, or
delete waveforms from the AC analysis.

Simulation Control Dialog

When the initial simulation is finished, the Simulation Control dialog
is displayed. The currently active simulation, AC, will be checked
in the “Mode” section.

The DoScript button is used to execute optional ICL script
commands in the script field of the dialog. The Abort button is
used to abort a script during its execution. As an option:

• Enter the following line into the script field of the
Simulation Control dialog.

ac dec 50 100hz 100khz

• Click on the DoScript button.

This dialog will be explored more closely in later sections.

REAL-TIME WAVEFORMS
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Scripting: Introduction to ICL

The bottom portion of the Simulation Control dialog is used for
entering and executing Simulation Scripts. This allows you to
interactively run analyses that were not included in the initial
ISSPICE4 netlist, or to change component values. Unlike other
SPICE simulators, you don’t have to quit ISSPICE4 and go to the
schematic in order to make changes. Simulation scripts use any
of the Interactive Command Language (ICL) functions (which are
discussed in on-line help) for SPICENET, IsEd, or ISSPICE4, or under
the Script Atoms help pop-up.

Let’s change the AC analysis specification.

• Type the line “ac dec 25 1001 100meg” into the Simulation
Control dialog. Click on the DoScript button.

Now let’s run a new analysis.

• Delete the ac line and enter the three lines shown below.
Click on the DoScript button.

ISSPICE4 WILL execute
the script and
perform the transient
analysis. The node
voltages stated in the
ICL view commands
will appear in the
real-time display.
The default scaling is
set by the .OPTIONS
parameter VSCALE.

Script Field
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Changing Component Values

Through the use of ICL commands, various circuit parameters
can be swept, and circuit performance can be measured with
minimal effort. To examine this feature;

• Modify the script in the Simulation Control dialog to
match the one which is shown below.

The alter command, as shown, is used to change the value of the
capacitor.

• Click on the DoScript button.

The new value for the capacitance, 100nf, will be set. The
transient analysis will then be run.

Various device parameters are available. For a complete list of
device parameters, and a complete description of the alter
command, see the on-line help for SPICENET, IsEd, or ISSPICE4.

Saving and Viewing Simulation Data

ISSPICE4 uses a plot name to represent the vector data for each

SCRIPTING: INTRODUCTION TO ICL
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analysis that is performed during a simulation. This same plot
name is used to store the vectors from all subsequent simulations,
as long as the Accumulate Plots option is not checked. If the
Accumulate Plots option is checked, the plot name is incremented
for each subsequent simulation, and the newly created vectors
are stored under the new plot name. The ICL display command
is useful for determining the available vectors for a plot.

• Check the Accumulate Plots option in the Simulation
Control dialog.

• Then, set the capacitance value to 10n and click the
DoScript button.

Notice that the simulation was run with the new value of 10nf,
and the plot name was incremented. We now have the vectors
from this and the previous simulation available for examination.

• Display the transient analysis data for the 100nf
capacitance value, by selecting the “tran2” entry in the
Plots pop-up in the Simulation Control dialog.

As plots are accumulated, the amount of memory that is used by
ISSPICE4 will increase. When a “save all allcur allpow” command
is used, the amount of required memory may become quite large.
However, the Accumulate Plots option, coupled with the ICL
script, is quite valuable for comparing circuit performance in
response to component variations.

• Change the component value and examine the various
plots that are created.

Script Atoms Help

The Script Atoms pop-up works with all available ICL functions,
including example syntax for each function.

• Delete the four transient analysis lines in the script window.
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SAVING AND VIEWING SIMULATION DATA

• Activate the Script Atoms pop-up by placing the mouse
pointer over the Script Atoms button and pressing the
mouse.

• Select the “show” entry in the Output submenu.

• Select all of the text in the “Example:” field of the Show
Help dialog. Press (<Ctrl>+C) to copy. Click in the Edit:
field. Press  (<Ctrl>+V) to paste the Example: text into
the Edit: field. Click on the OK button.

All of the information in the fields of the help dialog can be copied
to the “Edit:” field at the bottom. The OK button causes the Edit:
field contents to be copied to the script window at the cursor
position.

• Click on the DoScript button. Change the “show” function
to “show all” and click on the DoScript button again.

The show and showmod functions are used to display operating
point information. The output from these commands will be
displayed in the Output Window.

Script Atoms
button
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Completing the ISSPICE4 Tutorial

Take the time to examine the other commands which are listed
in the Script Atoms help pop-up menu. Try changing some of

the scripts in this tutorial. When you are finished exploring
ISSPICE4:

• Select Exit / Quit from SpiceNet’s File menu to end the
tutorial.
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Tutorial #5 - IntuScope

After a simulation is performed, you will want to view, analyze or
manipulate the output data. In IsSpice4, the circuit waveforms
are displayed in real time. However, the IntuScope program is
specially designed for more in-depth waveform analysis.

IntuScope can read the simulation data directly from the IsSpice4
simulator to gain access to all voltages, device currents, and
device power dissipations in the circuit. The data may be from
AC, DC, Noise or Transient analyses.

IntuScope can also display waveforms from an IsSpice4 output
file.

IntuScope is a versatile program, and has a wealth of functionality.
And even though this tutorial is fairly complete, we will not
discuss all of the capabilities of IntuScope. IntuScope is menu
and icon driven, plus contains context-sensitive help.
Experimentation is encouraged.

IntuScope was
completely
redesigned to
give you
enhanced
waveform
selection,
manipulation,
scaling, viewing
and math
operations.

Starting IntuScope

• Start ICAPS and open the Sample design (Sample.DWG)
in the :\spice8\SN\Sample2 directory.

• From the Actions menu, select Simulate.  Or click on

 the Run Simulation icon.

The simulation is launched and the IsSpice4 screen appears.

• From the Actions menu or top toolbar, select “Scope”
to launch the IntuScope program.

Run Simulation
icon
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The IntuScope Screen Layout

The IntuScope program contains a variety of windows. However,
most of the action takes place in the Graph Window, Add
Waveform dialog, and Scaling dialog boxes.

When IntuScope is launched, a new waveform Graph window is
opened automatically. Under IntuScope’s Windows pulldown,
use the Add Waveform dialog to plot your waveforms in the
Graph Window (if not cross-probing directly from the schematic).
Many of the fields at the bottom of IntuScope will be grayed out
until a waveform is displayed.

The Output Record Window (lower left corner) shows the result
of an ICL script that has been run, or any errors as a result of that
run say if the user created a waveform script with error. The
Commands Window allows you to optionally load an existing
script or type in your own. The Status Bar provides brief
instructions as to how to accomplish your current task in
IntuScope, if necessary. The Accumulator Window displays the
result of the measured values.

)
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Getting Help

From the Help menu:

• Select IntuScope Help for help on all menu functions.
• Optionally, select Script References for descriptions and

examples of the ICL scripts.
• Optionally, select Script Syntax for help on how to use

scripts to create simulation templates.

Opening a New Graph Window
Although unlimited new graph windows can be opened in IntuScope
the number of waveforms and plots created is limited to the
viewing space of the graph window.  When IntuScope is launched,
a new graph window will automatically open.

•   Under the File Menu, select New Graph to open a new
graph window.

• Under the Window menu, select Add Waveform to
display the Add Waveform Dialog.

Selecting a Waveform Data Type

IntuScope can access waveform data from any ASCII text
output file or directly from the IsSpice4 simulator. IntuScope will
automatically choose the best data source available.

There are three main types of waveform data:  Active IsSpice
Simulations, Active Project Output Files and Spice Output Files.
RF Deluxe users can also open Touchstone files, and plot S
parameters.

IntuScope has a complete online help system that contains
information on all menu functions and commonly used
operations.

The IntuScope Help Menu is dynamic.  It allows you to choose
from a list of HELP options, including movies, tutorials and
documents.
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To select an Active IsSpice Simulation:
 • Open up a drawing file in SpiceNet to activate a project.
• Run a simulation, which places all non-interpolated

simulation data in memory, as well as creates an ASCII text
.OUT file containing interpolated simulation data.

• In IsSpice4, select the Action menu, then Scope, to launch
IntuScope. By default IntuScope will link to the raw simulation
data as long as IsSpice4 is active, i.e., open.

• Plot any saved vector (wave) by clicking it in the Y Axis field
of the Add Waveform dialog, then click the Add button.

To select an Active Project Output File:
• Open a drawing file to

activate the project.
Run a simulation,
which creates a .OUT
file if one does not
already exist.

• Launch IntuScope.
•  Click on the Browse

button in the Add
Waveform dialog.

• Select the Active
Project Output File to
display only vectors
saved in the .OUT file.

• Highlight any vector
under the Y Axis and
click the add button
to plot the vector.

Only interpolated test point waveform vectors and vectors
specified with ICL commands are saved in the .OUT file. The
Active Project is your currently open schematic drawing file.
The Active Project Output File links to the .OUT file of the Active
Project. The IntuScope vector list will automatically update if the
.OUT file is changed by a new simulation run. Open a schematic,
then IntuScope without simulating, and IntuScope will by default
link to the Active Project .OUT file if the .OUT file exists. The
Active Project Output file only stores data for the specific
simulation, but the Active IsSpice Simulation holds all the data
from multiple simulation runs such as Tran1, Tran2, AC1, etc.
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To obtain data from different types of simulation runs in IntuScope:

•  Select the desired waveform vector set (simulation type)
from the Type drop down menu of the Add Waveform Dialog.

All available vectors for that selected vector set will show up in
the Y Axis box.

• Click on a desired vector in the Y axis list, then the Add
button to plot a waveform graph.

Here are some tips to make it easier to find vectors you want.

• In the Add Waveform dialog, find the Show section. Check
boxes for Voltage, Current, Power, Subcircuit and Other
waveform types should be available.

• Only waveform vector types with check marks next to them
will be available in the Y and X Axis list. Uncheck the
checkbox of any vector types you want to hide.

• For an Active IsSpice Simulation data source, a Test Pts
Only checkbox will be added to the top of the show list.
Check this to remove all non-testpoint vectors.

The Add Waveform Dialog provides control of how new waveforms
are plotted.

• Use the "Auto Scale" radio buttons to scale the y-axis of the
new waveform when it is plotted. Options include:

·  "New Trace Only," which creates a new y-axis scale for
the new trace without impacting any other traces that
may already be in the current plot.

·  "With Like Traces" re-scales all traces, including the
new one, whose y-axes have the same units as the new
trace.  This way, all can share a single y scale.

·  "Scale and Tile" re-scales all traces, including the new
one, so that the traces do not overlap each other.

• Check Make New Plot to make every new graph    appear
in a new plot.
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Selecting An Output File

If the simulator is running while IntuScope is launched, IntuScope
will retrieve non-interpolated (raw) data from the IsSpice4
simulator. Otherwise, IntuScope will retrieve the linearly
interpolated( re-sampled) data in the active project’s output file.

IntuScope is capable of displaying data, derived from different
output files, simulation analysis and X and Y axes, all on one
graph.  However, it  is recommended to separate the information
logically, using several graph windows.

To display the data that is not from the default output file:

• In the Add Waveform
dialog, click on the
Browse button.

• Select Spice Output
Files (.OUT).

• Select any .OUT file.
.OUT files are generated
when a simulation is
completed and placed
in the same folder where
the DWG was run.

   If the desired file is the
current Active Project
.OUT file:

• Choose the Active
Project Output File after
clicking on the Browse
button.

The .OUT file is an ASCII text file stored on a computer.  Even after
restarting the computer, you are still able to plot  waveforms with
the data from the .OUT file without re-simulation.  Warning!
Transient simulation uses a dynamic time-stop algorithm. The
variable stop data is interpolated into the .OUT file. Transient data
is more accurate when plotted from the Active IsSpice Simulation.
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Displaying A Waveform
To display a waveform:

Show section
enables you to
limit the listed
vectors  to the
ones  you
prefer.

Combining and Separating Waveforms

IntuScope enables you  to combine separated waveforms into
one plot, and to separate combined waveforms into several
new plots.
•   Open this drawing : \ spice8\Circuits\Demo\ac-dc.DWG

• Click  on the  run
simulation icon to launch
IntuScope.

• In the Add Waveform dialog’s
Show section, check Test Pts
Only, Voltage and Current.

• Make sure Make New Plot in
the Add Waveform dialog is
not checked, and with like
traces checked.

• Double click V_4 and V_8 in
the vector list to plot two
waveforms  in one plot.

•  In the Add Waveform
dialog,  click on the
Browse Button and select a
proper source.

•  Select a desired vector set
from the Type pulldown
menu.

•  Select  the Y and X axis
vector for the waveform
you want to plot.

•   Click on the Add button.
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•  Click any part of either
waveform (not waveform
ID tag).

•  Drag the cursor from the
current plot to the plot
you desire the waveform.

•  Release the mouse to
add the waveform  when
the cursor changes from

to
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To separate the graphs
into two new plots:

•  Click on any part of the
v_8 waveform  (not the
waveform ID tag).

•  Drag the cursor outside
of the current plot.
When cursor changes

from to  release

mouse button.
To combine two separated
graphs into one plot:
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Copying, Deleting and Renaming Waveforms

• Select a waveform by clicking any part of the wave-
form, except the ID tag.

 The waveform ID tag         should be filled in when selected.

To Copy A Waveform:

• Hold down the Ctrl key while dragging and dropping
the waveform to another plot.

• Release the mouse when the cursor changes from
to       .

To Delete A Waveform:

•  Press the Delete Key to delete the selected waveform.

To Rename A Plot:

• Select the Edit menu, Rename Plot.
• Or, double click on its label on the left of the plot,

such as Plot1.
• Type a desired name in the Rename Plot dialog.

 Move
waveform
left or
right.

Zoom in
on an
area of a
waveform.

Waveform
cannot
be
dropped
here.

Select
waveform
movement.

Move
waveform
up or
down.
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Cursor Control

The Cursor Control bar helps you to control the two cursors assigned
to it. It is located at the lower left hand corner of the IntuScope screen.
Cursors provide numerical information.

• Select the Windows menu and check Cursor Control,
or press  (<Ctrl>+K) to toggle Cursor Control ON if
it is not already ON.

• Select the Calculator menu, Cursors. Check Show
Default Cursors, then check Show Non-Default
Cursors.

• Click Select in the Cursor Control bar toward the
bottom of IntuScope.

• Click on the Add Cursor button twice to add
Cursors 2 and 3.

• Highlight  2 and 3 to activate Cursor 2 and Cursor 3.
• Click OK.

Cursor
Control
bar

Now Cursor 0 and 1 have been replaced by Cursor 2 and 3 in the
Cursor Control Bar as the active cursors.  The X, Y, and Delta
values are shown for the new active cursors.

•   Click Cursor 2 to hide it.  Click it again to show it.

There are several ways to move cursors along the waveforms:

 To move cursors with the mouse:

• Click on either cursor control box in your open graph.

• Hold and drag the mouse to reposition the cursor.

To move cursors by assigning X, Y values:

• Enter an X or Y value in the accumulator field above
the HELP button in the Cursor Control Bar.

 To turn Cursor Control on:
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Hiding and Selecting A Waveform

Several waveforms may be displayed in one plot and overlap
each other.

• Click the “2 to X” or “3 to X” buttons to assign your value
to the corresponding cursor.  The cursor will move to the
position of the value entered.

To move cursors one data point at a time to the left or right:

• Empty the accumulator field.
•  Click the Y < # (# means cursor #), or # > Y button.

To switch cursors from one waveform to another within the
same plot and in the same units:

• Click in the Cursor box (Note: the empty red box with the
small red horizontal line that intercepts the waveform).  Arrows
with four directions and a black horizontal line should appear.

• Move the black horizontal line up or down to other
waveforms within the same plot.  Release the mouse.

• Click the Home button in the Cursor Control bar to
reset the cursors one by one.

• OR press the Home key on the keyboard to reset both
cursors at once.

To hide an unwanted waveform:

•  Double click on its I.D tag (# on far
right of waveform) to make it invisible.

• Double click on the tag to re-display
the waveform.

To select the desired waveform:

• Click on the preferred waveform or its
I.D tag.

The position of I.D tags is also adjustable:
• Click on the desired waveform I.D tag.
• Hold the Alt key down and drag the tag left or right along

the waveform.
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Once a waveform is plotted, IntuScope can translate, or move,
and scale a waveform.

To Translate a Waveform:

• Click on a waveform’s I.D tag and hold down the left
mouse button. Drag the waveform up or down until it is
in the desired position.

• Or, select a waveform and press the up arrow or down
arrow keys to move the waveform up or down.

To Scale a Waveform:

•  Click on a waveform’s I.D tag.
• Press and hold down the Shift Key and the up arrow to

enlarge or down arrow to shrink.

Working With The Scaling Window

• There are two ways to bring up
the Scaling dialog.

1) Select the Window menu, then
    Scaling.
2) Select the Scaling menu,
    then Scaling Dialog. Scaling dialog

Scaling dialog is used to view and alter the scaling of the
active waveform.

Picture field

• Hold down the Shift key while
clicking directly on desired
waveforms to add multiple
waveforms for group scaling.

Note:  Both the selected and non-
selected traces’ x -axis scales
will be changed.  They all
share the same x-axis.

Translating and Scaling A Waveform
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Labeling and the Waveform Calculator
IntuScope provides a wealth of waveform calculator functions
(reference the Calculator menu pulldown). Amongst these,
labeling enables you to label typical values such as average,
peak to peak and minimum, directly on graphs.

• Click on the home button for both of the active cursors.
• Select Calculator menu, Labels, Average. OR Right click

on the Graph window and select  Label,  Average.
• Double click on the label to bring up Label Text dialog.
• Select Rotate and Transparent.
• Highlight the text and click on the Font button.
• Select Font Style, Bold and Font Size, 12. Click OK.
• Click OK to apply the changes and close the Label Text dialog.
• Drag and drop the Label Box to a free space in your graph.

 To label a specific point on your drawing:

• Select Calculator menu, Labels and Trace Comment.
The circle end point can be dragged along the waveform.

• Select Options, Save Preferences to save your settings.

Note: Labels can be placed  by selecting  Edit menu, Text Label;
Calculator menu, Labels, or by right-clicking in the graph.
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Working with IntuScope Scripts

Intusoft has extended the Interactive Control Language (ICL)
script commands and functions to work in IsSpice4, IntuScope
and SpiceNet. These Scripts enable automatic extraction of
important waveform information; ability to build and save new
waveforms; compare data from previous simulations; and save
results within the schematic database. The results of the
simulations are  automatically post-processed and made available
for further analysis.

You can perform an exercise to get familiar with scripts.

• Click the Run Simulation icon.
• Select the toolbar icon, Scope.
• In IntuScope, double click on V_8

and choose default for the X Axis.

• In IntuScope’s File Menu, select Load Script.
• In the Load Command Script Dialog, choose the

Measurements folder and Peak to Peak.scp.

If you don’t see the same script file, use its path to browse it:
:spice8\ln\scripts\measurements\Peak to Peak.scp  The
Script will be loaded in the Commands Window at the lower-
right corner of the IntuScope program.

V_8 graph
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• Open Sample.DWG circuit in the following directory:
:spice8\Circuits\Demo\Sample.DWG

• Set configuration and simulation setup drop-down boxes,
respectively to “Config1” and “all” on the top schematic
toolbar.



111

TUTORIAL #5 - INTUSCOPE WAVEFORM ANALYZER

•   Press Ctrl R to display the result.

• Click Calculator menu,
Functions, 20 Lgt.

IntuScope has many useful scripts commonly used.  You may
select the scripts from the Calculator menu as desired. You can
create or modify a script in IntuScope’s Command Window for
further analysis. For additional information on scripts, including
format, syntax and dozens of examples, go to
<http://www.intusoft.com/in/script/ScopeIndex.html>.

Updating A Waveform

IntuScope enables you to update current waveforms and make
comparisons between the new and previous ones: e.g., after
changing a component’s parametric value.

Let’s use the same circuit, Sample.DWG, to do the following
exercise.

• Select New Graph from the File Menu.
• In IntuScope’s Add Waveform dialog, select Test Pts Only

in the Show section.
• Click on V_8 to display the V_8 waveform.
• In the Action Menu, select Update, Add Updated Traces

(Note two other choices above and below this one).
•  Switch IntuScope back to the SpiceNet window.

The result will be
displayed in
IntuScope’s
accumulator field
above the Help
button.

Loaded
Script

Result

The plot of
20*lgt(V_8) vs. time
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• In the SpiceNet schematic, change the R18 value from
1K to 10K.

• Click on the    Run Simulation icon.
• Switch the window back to IntuScope from IsSpice4 by

pressing the ALT +TAB key, or IntuScope’s desktop icon.
• Select the Actions menu, then Update. Use Selected Mode

or  (<Ctrl>+U) to display the updated waveforms.

The new V_8 waveform will be displayed in the same plot with the
old one as shown above. You can easily compare and analyze
how different R18 values effect the behavior of  V_8.

Make sure the desired update method is checked before you
update. Check “Update Current Document” to replace old
waveforms with new ones when you update. Check “Add Updated
Traces” to display new waveforms next to previously plotted
waveforms. Finally, check “Add Updated Document” to plot new
waveforms in a separate graph.

You can also toggle "Use Original Analysis Type" or "Use
Selected Analysis Type." “Use Selected Analysis Type” is useful
for multi-pass simulations since you can plot a group of waveforms
for one analysis type, change to another analysis type, and
update all existing waveforms based on currently selected
analysis type. Choose Save Preferences under the Options
Menu to make these update methods the default setting for every
time you open IntuScope.
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Customizing The IntuScope Toolbar

•   In the IntuScope Options Menu, check Show Toolbar.
•   Select Customize Toolbar.
•   Select Category, Scripts .

To add an Icon to the
toolbar:

•  Drag the bode plot
button from the
Customize dialog to
the toolbar.

The destination will be
marked by a vertical line.

 To Remove an icon:

•  Drag the Bode plot icon off the toolbar
onto the open Customize dialog.

Description of the chosen icon.

Print Preview
• Select File menu, Print to display the print preview

window.
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Enter exact
values  within
the bounding
box or just drop
and drag it to
manipulate the
size of your
graph.

•  Click on the Copy to Clipboard button to place the
image on preview page into the system clipboard as
a Windows Meta File (.WMF).

Encapsulated Postscript File (.EPS file) may also be supported
depending on your printer.  The clipboard allows IntuScope
graphs to be imported into most word processing or desktop
publishing programs.

•  Click on Print button to print everything shown on
the graph except cursors.

Working With Smith Charts

The Smith Chart function built into IntuScope enables you to
determine the effects of altering network geometry during a Two-
port network analysis.

Let’s get familiar with Smith Charts by doing an exercise.

• Set the Configuration and Simulation setups to be
Sparams and 1k-1meg respectively.

• Click the Simulation icon.
• From the IsSpice4 Actions menu, select Scope.
• From Scope, select Calculator, Smith Chart, vs11

You will see a graph plotted similar to the one on the following
page.

From the plots you can  see how the real part  (waveform1) and
an imaginary part (waveform2) of S11 behave within a defined
frequency range,  from 1kHz to 1MegHz.  You may also be able
to see how vs11 moves in a Smith Chart at this frequency range.

• Open the TwoPort.DWG circuit with the following path
:spice8\Circuits\Networks\TwoPort.DWG
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IntuScope enables you to choose the
type of waveforms displayed in the
pulldown menu under the Y Axis
section.

• Click the Semi-Smith Chart.
• Hold Down the Shift key while

clicking on the Auto Scale
button inside the Scaling
dialog to display a full Smith
Chart.

A Smith Chart and a plot of the
sre11 and sim11 waveforms are
the result of selecting vs11 in
the Smith Chart submenu of
IntuScope’s calculator.

To View the full Smith Chart:
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You are also able to create or modify the circuit inside of a
TwoPort network box.

• In SpiceNet, select File menu, Open.

• Open :\spice8\Circuits\Networks\TwoPort0.DWG
• Change C2 2n value to 5n.
• Select Subdrawings menu, Modify Subdrawing.
• Subdrawing Name must be TwoPort to replace the

TwoPort part in TwoPort.DWG.
• Nodes 3, 2, 4 and 1 on the schematic above are nodes 1,

2, 3, and 4 on the created box symbol. How this works is
that we select the schematic nodes on the left and add it
to the pin list on the right going in a counterclockwise
direction, starting from the top left corner of the box
symbol.

Schemat ic
Nodes of the
m o d i f i e d
drawing

Nodes named
for the TwoPort
network box
symbol.
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•  For Symbol, select “No Change” then OK.
•  Select File menu, Export.
•  Choose SubCkt from the pulldown menu and click OK.

• Click OK for both
message dialogs.

Now you will see a pop-up IsEd-user.Lib dialog with duplicated
TwoPort netlists listed.
• Highlight the top TwoPort netlist and delete it.
• Save the changes
• DO NOT close the window.
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• Close TwoPort0.dwg

• Open :\spice8\circuits\networks\TwoPort.dwg

• Select Update Cache under the Parts menu.

• Click Apply button to update the netlist information

The old netlist inside of TwoPort network box has been replaced
by the newly created one.

 The changes made can be verified as follows:

• In SpiceNet, double click on one of the TwoPort symbols
in the schematic to bring up its Properties dialog.

• Select the Value field of .SUBCKT and click the Enter
button.

You will see the netlist of TwoPort network box shown in the Edit
Subcircuit dialog.
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• Run another simulation with Configuration and Simulation
setups still set to Sparams and 1k-1meg respectively.

• Change to the IntuScope window.

• In IntuScope, press <ctrl>+u to update the waveforms.

• Select Plot1 at the bottom, right mouse click and check
Link Master Trace.

• Select waveform 3 in the Smith Plot, right mouse click and
check Auto Label, Cursor 0.

• Select waveform 4 in the Smith Plot, right mouse click and
check Auto Label, Cursor 0.

• Move Cursor 0 in Plot1 below and the Auto Labels above
will update depending on where Cursor 0 is moved to.
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• Select Closed Loop and Tran for Configuration and
Simulation Setup, respectively.

• Click the Run Simulation icon to run the simulation.

• Press (<Ctrl>+T) to autoscale waveforms.

Working with SendScript

ICAP/4’s SendScript feature enables users to optionally send an
ICL script either from SpiceNet or IsSpice4, directly to IntuScope.
The script is automatically run in the IntuScope waveform
analyzer.

Let’s do an exercise to get familiar with this feature.

• Open Sample.DWG.  The path is
..\spice8\sn\sample2\sample.DWG.
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• From the File menu, select
<Save as Script> to create
the script for actions you
performed.

• Save the script file as
Example.SCP.

• From the Actions menu, select Scope.

• In the Add Waveform dialog, select Test Pts Only under
the Show field.

• Double click on the vled under the Y Axis to plot the
waveform.

• From the Calculator menu, select Labels/Maximum to
label the maximum point on the waveform.
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• Click Save to close the dialog.

•  From the File menu, select New Graph.

• From the File menu, select Load Script.

• Select and Open Example.SCP in the pop-up dialog.

• Highlight the script in the Commands window and
press (<Ctrl>+C) to copy to clipboard.

• Switch back to the SpiceNet window.

• Click on the Text icon on the right toolbar.

• Put the cursor in a free space in the schematic and
press (<Ctrl>+V) to paste the script into the schematic.

Now the example script has been loaded into the
Commands window.

Text icon
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•  Type Scope in the first line to send the script to
IntuScope.

• Press <Esc> key to go back to Normal Mode.
• With the mouse cursor over the text block, click the
   right mouse button and select Send Script.

The script you just created in SpiceNet has been sent to
IntuScope and run in the waveform analyzer.

Scope
* D:\spice8\In\Scripts\Example.SCP
newplot plot1
setsource d:\spice8\sn\sample2\sample.cir
plot1.vled = tran1.vled
plot plot1.vled
setscaletype lin lin
settracestyle solidln med
setxlimits 0 100n
setylimits 60.0m 110m
setplot Plot1
setvec vled
setcursor 0 0
setcursor 1 100N
setlabeltype plaintext
makelabel max
setlabel border true
setlabel justify left
setlabel rotated false
movelabel 0 0
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• Switch to the IntuScope window.  The Vled graph has
been plotted as shown below.

The graph is the same as the one plotted without using SendScript.

• Switch from the IntuScope window to the IsSpice4 window.

• Enter a different script as shown below, which plots Vin
in the simulation control dialog.

Note:  Always
keep IntuScope
activated before
sending scripts.

sendscript plot vin

Click
button for
help on script
syntax and
reference
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• Click on the DoScript button to run the script  in
IntuScope.

• Press (<Ctrl>+T) to rescale the plots in the IsSpice4
window.

• In IntuScope, drag and drop the label to a desired position.

 The graph looks similar to the one shown.
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Quitting IntuScope

Let’s exit out of the IntuScope  program

• Select File menu, Exit/Quit.

• Select Save to begin the graph saving process or select
“No” to discard the graphs and exit IntuScope.

To quit  SpiceNet and IsSpice4:

• Select  Exit/Quit  from the File menu in SpiceNet.

Congratulations, you have completed the IntuScope tutorial.
IntuScope contains a tremendous number of capabilities, only a
few of which have been discussed here.  The vast array of
functions are accessible through the pulldown menus, and are
explained in the in-application help system.
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AC Analysis - A Butterworth Filter

In this example, we will introduce the PWL voltage source and
demonstrate the effect of sampling theory, including how it
applies to IsSpice4.

New Topics Covered
Sources

• PWL...Piecewise Linear Voltage Controlled Source
Transient Analysis Control

• TSTEP...Time Step Control
Output Control

• Printout and Plot Resolution
• Magnitude/Phase Plot (.PRINT AC)

Analysis
• .PZ...Pole Zero Analysis

Specification:
Given the circuit below, we’ll determine the magnitude and
phase response vs. frequency (Bode Plot) and the pulse
response. Using the PWL statement, the input pulse should
have the following time voltage description:

Analog Simulation Examples

The PWL stimulus is generated by placing a voltage source on
the schematic, double-clicking on it to open the properties
dialog, double-clicking on Tran Generators field and then
entering the PWL data points in the PWL tab.

The .TRAN and .AC statements are created using the Actions
Simulation Setup Edit... function.

The .PRINT
Statements are
generated for you
by the test point
symbols. You DO
NOT have to type
them in!!

Open the schematic at :\spice8\Circuits\Examples\AC Analysis.DWG

Time (s)    Voltage (v)
0 0
1u 0
2u 1
20u 1
20.1u 0

41 2 3
C2
1.5307NF

R1
1OHM

L1
.38268UH

L2
1.5772UH

V1
C1
1.0824NF

V_1

V_4
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AC Analysis - A Butterworth Filter
.TRAN 5US 50US
.AC DEC 20 100HZ 100MEGHZ
.PZ 2 0 4 0 VOL PZ ; The .PZ statement is entered in the
R1 1 2 1OHM ; IsSpice4 Simulation Setup dialog
L1 2 3 .38268UH          ; in the user statement field.
L2 3 4 1.5772UH
C1 3 0 1.0824NF
C2 4 0 1.5307NF
V1 1 0 PWL 0S 0V 1US 0V 2US 1V 20US 1V 20.1US 0V AC 1
.END

• After entering the schematic, simulate the circuit. Be
careful to enter the piecewise linear voltage source
properly.

Refer to the IsSpice4 User’s Guide to clarify any syntax
questions. If any errors appear, check the error file by clicking
the ERR button in IsEd.

The voltage source, V1, has a piecewise linear transient signal
generator, as well as an AC source magnitude value. This is
perfectly all right. Sources can be assigned values for any or all
of the five main types of analyses: AC, noise, distortion, DC or
transient, on the same line. The values will each be used with
their respective analyses.

Bode Plot
After running a successful simulation, look at the plot of VDB(4)
and VP(4). You can look at various waveforms and variations
(magnitude, real, imaginary, phase, etc.) of the saved waveforms
using the IntuScope Add Waveform dialog. The schematic test
points automatically cause the phase and magnitude in dB to
be displayed in IsSpice4. The number of points we decided to
print per decade (20) is determined by the .AC statement. This
point interval determines how the output data will appear.

The magnitude/phase response for this example is shown on
the next page. Your X/Y axis labels may be different.

Be careful to
enter the PWL
points correctly.
Be sure not to
enter the letter
“O” in place of
the number
zero.

Check the .ERR
file for a listing
of the IsSpice4
error and
warning
messages if
your simulation
does not run.

Note: The
netlist
generated by
the schematic
will look
different.
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Pulse Response
Proper specification of control statements is critical to the
transient analysis. The minimum entries required for the transient
control statement are TSTOP and TSTEP. TSTOP is the total
analysis time. TSTEP is the sampling interval. The Nyquist
sampling theory will dictate the appropriate value of TSTEP.
TSTEP must be at least twice the frequency of the quickest
event in a simulation in order for the event to be captured.
However, in certain circumstances, trade-offs must be made
between acceptable accuracy and simulation time.

Examine the transient waveforms. Notice how the steep fall
time causes ringing at the output. Using inadequate sampling
can greatly effect the results you will receive from IsSpice4. The
graphs shown next were created by changing the TSTEP
parameter in the .TRAN statement, thus altering the interpolated
data recorded by the simulation. It clearly shows the effect of
variations on the data printout interval, TSTEP. Too few points
will cause data to be aliased or distorted. Too many data points
will increase the total simulation time and may provide data
beyond the scope of interest. Note that no matter how many
data points were taken, the final value was always the same.

Interpolated data
is used for the
waveforms when
the source is
“Active Project
Output File.”
Non-interpolated
“raw” data is used
for the waveforms
when the source
is “Active IsSpice
Simulation.”

Non-interpolated
data is normally
more accurate
and can be
controlled by the
TMAX and
RELTOL
parameters.

Magnitude

Phase
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Additional Notes On Accuracy

There are other parameters besides TSTEP that can affect the
accuracy of the output from a simulation. Some of these are the
TMAX parameter in the .TRAN control statement and the
RELTOL parameter in the .OPTIONS control statement.

The TMAX parameter in the .TRAN control statement controls
the maximum internal timestep of the simulator. The IsSpice4
simulator does not necessarily make calculations at every data
point requested by TSTEP. The internal timestep of the simulator
is variable, and changes depending on the conditions present
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in the circuit. All output data is interpolated from internally
calculated points. The TMAX parameter is used to control the
internal time step by limiting it to a specified maximum value.
This will allow the variable time points being used for interpolation
to be closer to the actual requested constant data point interval.
(TMAX should be set to one-half or one-fourth of TSTEP if
interpolation problems are suspected.)

The RELTOL parameter in the .OPTIONS statement controls
the overall accuracy of the simulator. The default value is set to
0.001. For most applications, RELTOL can be set to .01 (or
0.1% accuracy) to speed up the simulation without significantly
affecting accuracy.

VSECTOL

A new VSECTOL option  reduces the time step if the product of
the absolute value of the error in predicted voltage (prediction
– solution), and the time step, exceeds the VSECTOL
specification. As in most IsSpice options, its default is zero,
which turns the option off. In testing the VSECTOL option, we
ran some cases setting RELTOL=0.5 and at the same time set
VSECTOL to a reasonable value for the circuit. Figure 5 shows
this new time step control option. This introduces a completely
new time step control for the simulation, based on node voltage
accuracy.

Using snubber.dwg shown as a test circuit, we ran the usual
analysis. We set VSECTOL=50n, RELTOL=.5 and BYPASS =
OFF; no TMAX was needed in the .tran statement. On the other
hand, many parameters were modified to get SPICE to run this
circuit to completion, including setting TMAX to 20n. The
VSECTOL controlled simulation ran faster and produced more
detail in the switching transitions. The Bypass option controls
whether or not the device operating point is calculated for each
time step. When Bypass is ON, these load operations are
skipped if errors are low enough. Since RELTOL is used in the
calculations, we can’t use the BYPASS logic.

Use the
Convergence
Wizard to
resolve
convergence
errors.
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Pole-Zero Analysis
IsSpice4 has the capability to calculate the poles and zeros of
a transfer function. The syntax for the Pole-Zero analysis is
listed in the IsSpice4 User’s Guide. In this example, the poles
and zeros are requested for the transfer function defined by the
input nodes, 2 & 0, and output nodes, 4 & 0. The transfer
function is defined by the VOL entry to be: (output voltage)/
(input voltage). We could have instead used the CUR entry to
define the transfer function as (output voltage)/(input current).
The .PZ entry causes the calculated poles and zeros to be
placed in the output file. An example is shown below.

-------------- Pole - Zero Analysis -------------

Transfer function of (V(4) - V(0)) / (V(2) - V(0)) in Volts / Volt

Poles        Real      Imag               Number
      ------     ------ ------
-9.87068e+005 5.557209e+007   1
-9.87068e+005 -5.55721e+007   1
-3.19507e+005 1.798896e+007   1
-3.19507e+005 -1.79890e+007   1

• Try expanding the frequency range for the .AC analysis
by changing the .AC control statement to the following:

.AC DEC 20 100KHZ 1GHZ

• Resimulate the circuit with the new .AC statement and
examine the output.

Results using VSECTOL to control the time step produces
higher accuracy during the turn-off transition and uses less
computational resources when there is no switching activity.

Transient timepoints = 26015
Accepted timepoints = 14217
Rejected timepoints = 11798
Total Analysis Time = 35.15

Use the User
Statements field
in the IsSpice4
Simulation
Setup dialog to
enter the .PZ
statement.
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Transient Analysis - A Rectifier Circuit

Since not all circuits are made with passive components, it is
time to advance and see how to use active devices. This
example will demonstrate how to call and use IsSpice4'S built-
in diode model.

New Topics Covered
Sources

• V...Independent Voltage Source
SIN...Sinusoidal Transient Statement

Semiconductors
• D...Diode call

Miscellaneous
• .MODEL statement

Specification:
The circuit we will construct and simulate is shown on the next
page. The input stimulus consists of a sinusoidal signal with 0
volt offset and a peak value of 1 volt at 1kHz. The SIN stimulus
is generated by placing a voltage source on the schematic,
double-clicking on it to open the properties dialog, double-
clicking on Tran Generators field and then entering the SIN data
into the SIN tab.

The DC voltage source will have a value of .5 volts. Data will be
collected every 10µs for 2ms at nodes 1 and 2 using a transient
analysis and two test points. We will use the 1N4148 diode. This
diode can be found using the X Parts Browser.. function under
the Parts menu.

• Enter the design and run the simulation.

Note:  It is not necessary to type the .MODEL statements.
SpiceNet will retrieve the models from the ICAPS SPICE model
libraries in the PR directory automatically.

Open up the drawing
:\spice8\Circuits\Examples\TRANAnalysis.DWG
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In the above netlist, you will notice the .MODEL statements. All
semiconductor devices used in an IsSpice4 simulation must
have a .MODEL statement associated with them. This statement
is used to describe the semiconductor device by passing a set
of parameters that fill predefined equations. These equations
are then used to simulate the device. Semiconductor devices
require two statements in a netlist. One line, the diode call line,
describes the connections (i.e. D1 2 1 DN4148). The second is
the associated .MODEL statement, which is referred to by the
diode (i.e. .MODEL DN4148 D (CJO=...). The model name in
the .MODEL line must match the one on the diode call line
(DN4148). The schematic handles this syntax for you.

As explained in the previous example, the .TRAN parameters
are extremely important when performing a transient analysis.
The output is a direct result of the TSTEP entry in the .TRAN
statement, and should be set to adequately sample the
waveform. Unfortunately, the highest output frequency is not
always known. Hence, the .TRAN statement should be set to
examine the expected output from a circuit. Unresolved artifacts
can always be examined with another simulation at an reduced
sampling interval.

The IsSpice4
model and
.PRINT
statements are
only shown for
clarity. They DO
NOT need to be
typed in!

Transient - A Rectifier Circuit
*#save V(1) @V1[i] @V1[p] V(2) V(3) @R1[i] @R1[p] @V2[i]
*#save @V2[p] @D1[id] @D1[p] @D3[id] @D3[p]
*#alias vin  v(1)
*#view  tran vin
*#alias vout  v(2)
*#view  tran vout
.TRAN 10u 2m
*#save all allcur allpow
.PRINT  TRAN Vin
.PRINT  TRAN Vout
D1 2 1 DN4001
.MODEL DN4001 D BV=75V CJO=55PF
IS=1.38E-09 M=.38 N=1.7
+ RS=.04 TT=5U VJ=.34V
V1 1 0 SIN 0 1 1k
R1 2 3 1
V2 3 0 DC=0.5
.END

Print, Save, and
Alias statements are

generated by the
test points symbols

1

V1

2

D1 1N4148 

3

R1
1

V2
0.5

Vin
V(1)

VOUT
V(2)

SIN
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In this circuit, we used a 1kHz SIN wave. One period occurs
every 1ms. Since the main interest of the circuit focuses on the
response to the 1kHz sin wave, we must choose a sampling
interval that will generate acceptable output. By adhering
strictly to the Nyquist theory, the output should be sampled at
least every 0.5ms. The choice of 10µs was used to obtain
detailed output without causing excessive simulation time.

• To continue the example, replace the DN4148 diode
with a DN4001 diode.

Note: After placing more than one model for the same kind of
part, you can switch between the different models by using the
.Model field in the part’s properties dialog.

• Rerun the simulation.

The results of the simulation for the circuit containing the
DN4148 and DN4001 diode are shown below.
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Q1 NC NB NE QN2222
.MODEL QN2222 NPN

NCNA NC

NB
NS

NG

ND

NB

NG

ND

NS

NG

ND

NS

NE

J1 ND NG NS J2N
.MODEL J2N  PJF

Z1 ND NG NS J2N
.MODEL GAS  NMF

M1 ND NG NS NB  N1
.MODEL N1 NMOS

D1  NA  NC  DN4148
.MODEL DN4148  D

Normally,
models are
retrieved
automatically
from libraries.

Proper Use of Semiconductor Devices
When using semiconductor devices, care should be taken to
ensure that the proper connections are made. An incorrectly
connected device may satisfy simulator connectivity
requirements, but may cause your circuit to run improperly or
cause IsSpice4 to abort the analysis.

Listed next are five types of semiconductor devices that are
available in IsSpice4, their connections, and an abbreviated
example of each device's model statement. The model
parameters can be edited directly in the schematic using the
part properties dialog. Any changes will be local to the schematic.
The semiconductor devices are called using the D, Q, J, M, or
Z keyletters, and must be properly defined by an appropriate
.MODEL TYPE parameter. For example, Q should list an NPN
or PNP type.
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DC Sweep - Device Characteristics

In this example, we will explore the use of the IsSpice4 JFET
model and how to obtain its forward DC characteristics.

Specifications:
A DC analysis will be performed and the DC sources VDS
(Drain-Source voltage), and VGS (Gate-Source voltage), will
be swept to obtain the drain current characteristics. VDS will be
swept from 0 to 5V in .2V steps, and VGS will be swept from
 -5v to -7V in -.5V steps. The voltage source, V2, will be used
to measure the drain current. Output will be obtained for the
Drain-Source voltage, VDS, and the Drain-Source current,
I(V2).

Note: You must make the reference designations in the voltage
source properties dialogs match the ones shown in the schematic
below if the .DC statement is to work properly.

New Topics Covered
Sources

• Current meter
Semiconductors

• JFET
Analysis

• DC Sweep
Output Control

• .PRINT DC

DC Sweep - Device Characteristics
.*#save all allcur allpow
.PRINT  DC IY1
VGS 3 0
J2 1 3 0 J105
.MODEL J105 NJF AF=1 BETA=5M CGD=1.40E-10 CGS=8.00E-11
+ FC=.5 IS=9.48E-14 KF=3.886E-16 LAMBDA=.035 RD=4.20E-01
+ RS=3.78E-01 VTO=-7.25 PB=1.00
V2 2 1
VDS 2 0
.END

The IsSpice4
model and
.PRINT
statements are
only shown for
clarity. They DO
NOT need to be
typed in!

Open up the drawings at
:\spice8\Circuits\Examples\DCSweep.DWG



139

ANALOG SIMULATION EXAMPLES

DC Analysis
The .DC control statement is used to specify a DC analysis. In
a DC analysis, any voltage or current source may be swept.
Node voltages or branch currents requested in the .PRINT DC
statements will be recorded. The DC analysis statement .DC
VDS  0V 5V  .2V  VGS  -5V -7V  -.5V will sweep the voltage
source VDS from 0 to 5V, in .2V steps. For each step of VDS,
VGS will be swept from -5V to -7V in -0.5V increments. Data will
be saved for each combination of VGS and VDS. In this case,
the current through the voltage source, V2, (.PRINT DC I(V2)),
will be measured. The value of VDS is obtained automatically
from the DC analysis, because it is the first swept variable.

You are likely to notice that the voltage sources do not need any
values. In a DC analysis, the source values are driven by the
.DC control statement. The .DC statement will override any DC
or transient values entered into the properties dialog during the
.DC analysis, but will allow the values to be used for the AC and
transient analyses.

JFET Semiconductor
Like the diode, there are two lines that identify a JFET. The call
line, (J1 1 3 0 J105), and the .MODEL statement, (.MODEL
J105 NJF (VT=...).  The .MODEL statement DOES NOT have
to be typed into the schematic. It will be added to the netlist
automatically.

Current Measurement
Another new function performed by this example is the
measurement of current. In IsSpice4, current can be measured
through any element. In this example, the current meter, V2,
does not contribute stimulus to the circuit since its value field is
not stated. It only exists to measure current flow. A blank value
field is interpreted as zero volts. For other devices, current is
specified by inserting a current test point (Parts Menu, 3Y) in the
symbol. You can also use the .PRINT DC statement by placing
the @ sign before the model's Reference Designation, followed
by the desired current (between square brackets).

. For example; .PRINT DC @J1[ID]
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The output for this example is shown below.

Transmission Lines - Buffering and Impedance Matching

In this example, we will demonstrate three new elements, the
voltage controlled voltage source (VCVS), and two transmission
lines (T-Line - both lossless and lossy). We will use the VCVS
to simulate an ideal op-amp and the T-line to investigate
impedance matching.

New Topics Covered
Sources

• E...Voltage Controlled Voltage Source
Passive Elements

• T...Lossless Transmission Line
• O...Lossy Transmission Line

Specification:

VGS=-6v

VGS=-5v

VGS=-5.5v

Plot i_v2, then
run parametric
cursors by
invoking
IntuScope;
Calculator
menu;
Measurements;
parametric
cursor.  Move
cursor1 along
the created
curve at the
bottom to obtain
all the values of
the DC sweep
curve at the top.
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For the circuit shown below, the input voltage source will
consist of a pulse train with an initial value of .5V, a final value
of 3.5V, no delay, rise and fall times of 3ns, a pulse width of
22ns, and a period of 50ns. The VCVS will have a gain of
10,000. The lossless T-line will have a time delay (TD) of 2ns,
a characteristic impedance of 75W and a length of 1 meter. The
lossy T-line will have a time delay of 2ns, an impedance (Zo) of
75W and a series resistance of 4W/m. Transient analysis data
should be collected every 1ns for 100ns, starting at time 0. We
will investigate the output of the op-amp and the T-line. We will
also investigate the effects of losses and length for the best
matching circuit.

T-Lines - Buffering and Impedance Matching
*#SAVE ALL ALLCUR ALLPOW
.TRAN 1N 100N 0 1N
.PRINT TRAN  V(1)  V(3)  V(4)
R1 1 2 1K
E1 3 0 0 2 10K
R2 2 3 10K
T1 3 0 5 0   ZO=75 TD=2N  ; Symbol Ideal T line
R3 5 4 150
C1 4 0 10P
V1 1 0 PULSE .5 3.5 0 3N 3N 22N 50N
.END
Buffering
The VCVS in this circuit is modeling an ideal op-amp. The

resistors, R1 and R2, create a simple inverting amplifier
configuration with a gain of 10. This inverting amplifier essentially
buffers the input voltage source to the transmission line.

“ZO=75
TD=2N” must
be entered into
the lossless
transmission
line’s Properties
dialog.

Open up the schematic at :\spice8\Circuits\Examples\TLine.DWG
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Impedance Matching
The 150W resistor and the 10pf capacitor form a series
 impedance match to the transmission line. As the output
shows, this termination scheme is quite poor.

• To improve the matching, replace the 150WWWWW resistor
and 10pf capacitor with the parallel termination shown
to the left. Simulate the circuit again. The new
statements are shown below for reference.

R3 4 0 75
C1 4 0 5P

Now that the circuit has better matching, let's examine the
impact of a longer transmission line and the effects of a less-
than ideal T-line.

•  To do this, replace the current Lossless T-line symbol
with the RLCG Lossy Tline symbol.
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The symbol RLCG Lossy T Line is found under the Parts menu,
Passive submenu.

• Enter the model name “line” in the Lossy Tline’s .Model
pop-up field in the properties dialog.

The model name links the lossy transmission line element to a
set of model parameters. To calculate the necessary
parameters, we will use the following conversions.

In this example, LEN=1 meter, TD=2ns, Zo=75W, Vp is phase
velocity (m/s), L is inductance (H/m) and C is capacitance (f/m).
Evaluating the equations yields the parameters for the following
.MODEL statement.

.MODEL LINE LTRA(R=0 L=150n G=0 C=26p LEN=1)

• Enter the LTRA parameters values in the Part
Properties dialog. Simulate the parallel and series
termination circuits with this new transmission line.
The results should be comparable.

• With the transmission line in this form, it is quite easy
to investigate the effects of lengthening the line. To do
this, simply change the value of LEN in the Part
properties dialog.

• Simulate the series terminated circuit with different
lengths. The results for simulations with 1, 5 and 10
meter segments are shown on the following page.

Finally, we can determine the effects of losses in the line. This
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is done by setting R to a nonzero value. Unfortunately, it is not
as easy as plugging in a value. If R is included, the characteristic
impedance (Zo), and phase velocity (Vp) will change. This will
change the values of L and C. For this example, however, we
will simply add a unit resistance of 4W/m and simulate the circuit
for a 50m line.

• Replace the values for the lossy line parameters with
the following parameter values.

R=4 G=0 L=150n C=26p LEN=50

By increasing the length of the line, we have also increased the
time delay. Because of this, the TSTOP parameter in the .TRAN
statement must be increased. Replace the .TRAN line with
.TRAN 1N 200N 0 1N.

• Simulate the series-terminated circuit with the new
lossy line. The results are shown next. Note the
attenuation in the line caused by R.
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Using Subcircuits - Active RC Filter

There are four types of devices in IsSpice4; passive elements,
active elements, C code models and subcircuits. Thus far, we
have limited our examples to primitives. In this example, we will
introduce a 4th order Bessel low-pass filter circuit that uses a
subcircuit representing a UA741 op-amp. Since the UA741 is
too complicated to be represented by only one component, it
uses a collection of primitive components put together in a
topology that produces the characteristics of a UA741.

New Topics Covered
Subcircuits and Models

• X...Subcircuit Call
• .SUBCKT .ENDS

Output
• .PRINT Real Imaginary

Specifications:
Given the circuit shown below, we will determine the frequency
response. The AC stimulus will have be 1. Data will be collected
at node 8 from 1Hz to 1GHz at 20 points per decade. The data
will be displayed in magnitude and phase, and real and imaginary
formats.

The UA741 is
located in the
Part Browser
dialog under the
Op-amps Part
Type, Intusoft
Sub Type
listing.

Open up the schematic at
:\spice8\Cirsuits\Examples\Subcircuits.DWG
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Subcircuits
Important Note: As with .Model statements, .SUBCKT subcircuit
netlists DO NOT have to be typed in.

A subcircuit netlist is enclosed by a .SUBCKT statement at the
beginning, and a .ENDS statement at the end. All connections
into and out of a subcircuit are specified on the .SUBCKT line.
The subcircuit name is also given on the .SUBCKT line. This
can be seen in the partial listing of the UA741 subcircuit shown
below.

.SUBCKT UA741 2    3  6   7   4
 *             - IN + OUT VCC VEE
 RP 4 7 10K
 RXX 4 0 10MEG
.
.
.
 L 14 6 30UHY
 RL 14 6 1000
 CL 6 0 3PF
 .ENDS

L 14 6 30UHY
RL 14 6 1000
CL 6 0 3PF
.ENDS
.AC DEC 20 1HZ 1GHZ
*#ALIAS  VOUT V(8)
.PRINT AC  V(8)  VP(8)
.PRINT AC  VR(8)  VI(8)
R1 1 7 3.375K
R2 7 3 2.25K
C1 7 0 .26U
X1 3 0 4 2 9 UA741
R3 4 5 10K
R4 5 6 10K
X2 8 6 8 2 9 UA741
C2 6 0 .031U
C3 5 8 .0806U
C4 3 4 .0796U
R5 7 4 6.75K
V2 9 0 -15
V3 2 0 15
V1 1 0 AC 1
.END

Using Subcircuits - Active RC Filter
*#SAVE ALL ALLCUR ALLPOW
.SUBCKT UA741 2    3  6   7   4
*             - IN + OUT VCC VEE
RP 4 7 10K
RXX 4 0 10MEG
IBP 3 0 80NA
RIP 3 0 10MEG
CIP 3 0 1.4PF
IBN 2 0 100NA
RIN 2 0 10MEG
CIN 2 0 1.4PF
VOFST 2 10 1MV
RID 10 3 200K
EA 11 0 10 3 1
R1 11 12 5K
R2 12 13 50K
C1 12 0 13PF
GA 0 14 0 13 2700
C2 13 14 2.7PF
RO 14 0 75

Aliases are
generated by

the Test
points

Node zero is
ground in
subcircuits. It is
the SAME
ground that is in
the main circuit.
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The node list on the .SUBCKT line is important. The order of the
nodes determines the connections between the subcircuit
netlist and the “X” call line. In this case, the comment line below
the .SUBCKT line details the proper connections. The calling
line in the main IsSpice4 netlist would look like the following;

X1 3 0 4 2 9 UA741

This call to the UA741 subcircuit would connect 3 to the
inverting input, 0 to the non-inverting input and so on. The
actual node numbers on the calling line are not important. Only
their position is important. Also, there must be the same
number of nodes on the calling line as there are on the
.SUBCKT line.
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Note: The SpiceNet symbol takes care of generating the
proper X subcircuit call line. If the symbols are made with the
proper pin order relative to the .SUBCKT netlist, then the
subcircuit will connect properly to the symbol.

The AC analysis output is shown below. If your output differs or
you are unable to obtain this output, look in the error file for any
errors and check the circuit values.

Advanced Macro Modeling - Saturable Core

The following example uses 2 parameterized subcircuits, an
ideal transformer and a nonlinear saturable core model to
perform an analysis of a complete transformer circuit.

New Topics Covered
Subcircuits

• Using Multiple Subcircuits

Specifications:
The following circuit is used to simulate a transformer and its
nonlinear core characteristics. We will investigate the input
current, secondary output voltage and the core flux. A transient
analysis will be performed and data will be collected every .1µs
for 50µs, starting at time 0. The input stimulus will be a pulse
train from -5V to 5V with no time delay, 1µs rise and fall times,
a 25µs pulse width and a 50µs period.

Open up the drawing at :\spice8\Circuits\Examples\MacroModeling.DWG
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The magnetic core and transformer elements are generic. They
can emulate many different kinds of nonlinear cores and
transformers simply by specifying a set of parameters  before
running the simulation.

• After placing the CORE symbol, open the Properties
dialog by double-clicking on the symbol.

• Enter the parameters values in the correct Properties
fields using the following information:

VSEC=50u  IVSEC= -25u  LMAG=10m  LSAT=20u  FEDDY=20k

The CORE part
is located under
Magnetic Cores
Part Type,
Generic Sub
Type. The
XFMR part is
located under
Transformers.

• You will need to do the same with the XFMR part. Use
a parameter value of “RATIO=.3”.

Most subcircuits have default values for their parameters. If so
they will be listed in the properties dialog.

• To make the X-Y plot, select the v(4) md +  (vm1) Add
Waveform dialog.

Saturable Core, Advanced Macro Modeling
.SUBCKT CORE#0 1 2 3
RX 3 2 1E12
CB 3 2 1E-7  IC=-250
F1 1 2 VM1 1
G2 2 3 1 2 1
E1 4 2 3 2 1
VM1 4 5
RB 5 2 100K
RS 5 6 200
VP 7 2 250
D1 6 7 DCLAMP
VN 2 8 250
D2 8 6 DCLAMP
.MODEL DCLAMP D(CJO=191P VJ=25)
.ENDS

.SUBCKT XFMR#0 1 2 3 4
RP 1 2 1MEG
E 5 4 1 2 300M
F 1 2 VM 300M
RS 6 3 1U
VM 5 6
.ENDS
.TRAN .1U 50U
R1 1 2 100
VM1 2 3  0
X1 3 0 4 CORE#0
*{VSEC=50U IVSEC=-25U LMAG=10MHY
+ LSAT=20UHY FEDDY=20KHZ }
X2 2 0 5 0 XFMR#0
* {RATIO=.3}
R2 5 0 50
V1 1 0 PULSE -5 5 0 0 0 25U 50U
.END
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The results for this example are shown  in the following graph:

• The waveform is created in IntuScope using an X-Y plot
of the current through the core (vm#1branch = I(VM1))
versus the core flux.

A voltage equal to the core flux is brought out from inside the
subcircuit to a test point on the symbol. To measure the core
flux, simply attach a test point symbol to the symbol pin.

Although this example does not introduce any new IsSpice4
syntax, it does introduce a new concept, macro modeling.
Macro modeling is the name given to the process of combining
IsSpice4 primitive components in such a way that they perform
the function of a single device.

The Core subcircuit uses the macro modeling concept to model
the nonlinear saturation effects present in magnetic core
materials. A complete explanation of the core model is located
in the Working with Models book.

If any errors
occurred,
remember to
examine the
error file for
error
messages.
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In-line Math Equations - AM Modulator

This example introduces the nonlinear dependent source (B
element). The B element can generate an output voltage, or
current, based on a transfer function or mathematical expression.
Equations can use a predefined set of math functions and any
voltage or current in the circuit. As an example of the power of
this source, we will simulate a simple AM modulator circuit.

New Topics Covered
Sources

• B...Nonlinear Dependent Source

Specifications:
An amplitude modulated signal, s(t), is defined by combining a
carrier,

and a message, m(t), by the following equation;

or,

where ka is the amplitude sensitivity. If we consider a single tone
modulation such as;

so that the amplitude modulated signal becomes;

This equation can be generated by the nonlinear dependent
source quite easily. The equation for the nonlinear source
would be

v = (1 + V(1)) * V(2)
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We could have generated a current output with the B source by
replacing “v=” with “i=”. For example, B1 3 0 I=(1+.1*(v(2))*v(1)).

The final signal generated at the output of the B source is;

where Ac=1, Am=1, ka=.1, fc=100kHz, and fm=10kHz.

A Fourier transform of this equation yields a spectrum of an AM
signal. Keeping to positive frequencies, delta functions appear
at fc, fc+fm and fc-fm.

Both the time domain and frequency domain waveforms of
V(3), alias Vout, are shown in the graph on the next page.

IntuScope can take the FFT of any time domain waveform (FFT
of s(t) shown on the next page). Both Time-to-Magnitude and
Time-to-Real/Imaginary transforms are supported.

The netlist and circuit
for the this example are
shown as follows.

.TRAN .5u 1m 0 .5u

.PRINT  TRAN Vin1

.PRINT  TRAN Vin2

.PRINT  TRAN Vout
V1 1 0 SIN 0 1 100k
V2 2 0 SIN 1 100m 10k
B1 3 0 V=(1+.1*(v(2))*v(1))
.END

Open up the drawing at
:\spice8\Circuits\Examples\AMModulator.DWG
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Vout

(1+.1*(v(2))*v(1))
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If-Then-Else - A Comparator

The B source is also capable of making decisions using an If-
Then-Else expression. This is extremely useful when modeling
components or portions of a circuit where the output depends
on the state of the input compared to a known constant (e.g., a
comparator).

New Topics Covered
Sources

• B...Nonlinear Dependent Source

Specifications:
The comparator will have an on voltage of 5V and an off voltage
of 0V. The comparator will trigger when the input voltage
difference is greater than zero. The easiest way to model this
comparator is with an If-Then-Else function. The output of a
comparator will change state depending on the condition of the
two inputs. This function can be written as; If the difference
between the inputs is greater than zero, Then the output is high,
Else the output is low. The syntax for this particular device is:

B1 3 0 v= V(1,2) > 0 ? 5 : 0

1 vout 2 mag(fft(temp))

5.00u 15.0u 25.0u 35.0u 45.0u
time in seconds
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ut

 in
 v

ol
ts

P
lo

t1 1

90.4k 95.2k 100k 105k 110k
frequency in hertz

10.0m

30.0m

50.0m

70.0m

90.0m

m
ag

(ff
t(t

em
p)

) i
n 

vo
lts

P
lo

t1
_f

2



155

ANALOG SIMULATION EXAMPLES

This can be read as:

If (V(1,2) > 0) Then V(3)=5

Else V(3)=0
Open up the drawing at :\Spice8\Circuits\Examples\Compar.dwg

The B element can be used directly in a schematic, however,
it has no nodal input connections making schematic capture
arkward. This is due to the fact that the input to a B element is
an arbitrary expression and can be made of node voltages,
device currents, and other quantities.

An example B element dialog is shown next. It should be noted
that if you refer to a node voltage or device reference designation
it is best to give the node or ref-des a unique identifier, such as
VTEST for a node and ROUT for a resistor ref-des. This will
prevent SpiceNet from changing the node or ref-des during the
course of capturing the design, and hence breaking any
expressions you may have entered for B elements. In our
example drawing we renamed v(1) and v(2) to vin1 and vin2
respectively.

3

B1
Voltage

R1 1k 

Vin1 Vin2

Vin2Vin1

Vout

V(Vin1,Vin2) > 0 ?
5 :
0

Vin1 PWL 0 0 100U 1 200U 0
Vin2 DC 0.5

VIN1

Tran

1.05

-50.0M
200U0 time

VIN2

Tran

2.50

-1.50
200U0 time

V(3)

Tran

5.25

-250M
200U0 time
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The results of the simulation are shown below.

1 vin1 2 vin2 3 vout 4 difference

20.0U 60.0U 100U 140U 180U
time in secs

-380M

860M
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Difference=Vin1-Vin2

If Y>0 THEN 5V ELSE 0V
Y=0V at X = 50.0U secs

If Y>0 THEN 5V ELSE 0V
Y=0V at X = 150U secs
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GaAs MESFETs - An Inverter

IsSpice4 includes GaAs MESFET models based on the Statz
and Parker-Skellern models. The model parameters are detailed
in the IsSpice4 User’s Guide.

New Topics Covered
Sources

• Z...GaAs MESFET Model
Output

• .PRINT...Computed Device Parameters

Specifications:
Using the circuit below, we will investigate the response of the
GaAs inverter to an input clock with 125ps rise and fall times,
and a pulse width of 375ps.

An Inverter - GaAs MESFET
*#SAVE ALL ALLCUR ALLPOW
.TRAN 10P 1N
.MODEL NM NMF (VTO=-2.0 BETA=1M LAMBDA=1E-4
+ RD=100 RS=100 CGS=40F CGD=5F PB=.6)
.MODEL NM1 NMF (VTO=-1.8 BETA=.8M LAMBDA=1E-4
+ RD=100 RS=100 CGS=70F CGD=15F PB=.6)
.PRINT TRAN @Z1[GDS] @Z2[GDS] @Z1[GM] @Z2[GM]
.VIEW TRAN V(2) 0 3.5
.VIEW TRAN V(1) -1 0
.VIEW TRAN @Z1[GDS] 0 4M
.VIEW TRAN @Z2[GDS] 0 2.50U
.VIEW TRAN @Z1[GM] 0 4M
.VIEW TRAN @Z2[GM] 0 2M
V2 1 0 PULSE 0 -1 100P 125P 125P 375P 1
Z1 4 2 2 NM1
Z2 2 5 0 NM
V1 5 0 3.5
.END

The GaAs MESFET is called by pressing the number 4 and the
letter Z. Once the MESFET is placed on the schematic, a
.MODEL statement must appear for every MESFET with a
different model name. In this example, two .MODEL statements

The .PRINT,
statement is
entered in the
User Statement
field in the
IsSpice4
Simulation
Setup dialog.

Open up the
drawing at
:\spice8\
Circuits\
Examples\
GaAsMEFET.DWG

Z2
NM

Z1
NM1
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must be made, one for “MN” and one for “MN1.” If the model was
the same for both devices, then only one .MODEL line would be
needed. You can enter the model parameters for each MESFET
through the MESFET’s Part Properties dialog. The parameter
values can be seen from the netlist on the previous page.

The .PRINT command uses the reference designators listed in
the circuit, and the MESFET parameters listed in the on-line
help (press Property Help in the MESFET Properties dialog).
This obtains the transconductance and drain-source conductance
for both MESFETs. These device related parameters are not
generated by the test point symbol. They must be typed in by
hand by inserting a .PRINT statement in the IsSpice4 Simulation
Setup dialog, User Statements area.

The output for this example is shown below.
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Simulating at Different Temperatures - Simple Amplifier

In this example, we will demonstrate how to simulate circuits
and components at different temperatures. This can be
extremely useful when determining the reliability of a circuit
design in a harsh environment, or when an active device in the
circuit is subjected to heat stress.

New Topics Covered
Temperature

• .OPTION TEMP Parameter
• Temperature Control of Active Devices
• Resistor Temperature Coefficients

Analysis Control
• .TRAN...TSTART, TSTOP, TSTEP

Specifications:
Given the circuit shown, we will investigate the effect of
temperature variations on the base of the transistor. The input
stimulus will be a pulse train with an initial value of 0V, a peak
value of 5V, rise and fall times of 10ns, a pulse width of 500ns
and a period of 1µs. Data will be collected from 400ns to 1.2µs,
in 1ns steps. Output will be generated for node 3. The first
simulation will be performed at room temperature. The second
simulation will be performed with the entire circuit at 75°C. The
third simulation will be performed with the temperature of the
transistor set to 75°C and the rest of the circuit at room
temperature.

Open up the
drawing at
:\spice8\
Circuits\
Examples\
Temperature.DWG
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Simulating at Different Temperatures
*#SAVE ALL ALLCUR ALLPOW
.MODEL RMOD R(TC1=.01 TC2=1E-6)
.PRINT TRAN  V(3)
R1 1 2 30  RMOD ; enter Rmod in the .Model Value field
V1 2 0 30
R2 3 4 50  RMOD
V2 4 0 PULSE 0 5 0 10N 10N 500N 1U
Q1 1 3 0 QN2219
.END

• Construct and simulate the circuit. If you encounter
any errors, remember to examine the error file. Be
careful to enter the schematic exactly as shown.

Notice that the .TRAN line has four parameters. In addition to
the TSTEP and TSTOP parameters, we have added the
TSTART and TMAX parameters. The TSTART parameter is
used to tell IsSpice4 to start collecting data after 400ns. The
simulation will still start at time zero. However, IsSpice4 will not
record any data until 400ns. This parameter is used to reduce
the amount of data saved in the output file. The last parameter
on the .TRAN line is used to set the upper limit on the internal
IsSpice4 timestep. Setting this parameter to a value less than
TSTEP will improve the data point interpolation and thus
increase the accuracy of the results placed in the output file.

You will also notice a .MODEL statement for a resistor in the
netlist. This statement is used to place the temperature
coefficients on all of the resistors in the circuit. The name,
“RMOD,” which is used to reference the .MODEL statement,
occurs on all of the resistors. You only need to enter the RMOD
model name once in one of the resistor properties dialogs, along
with the TC1 and TC@ values. You can then select the RMOD
model while in the other resistor properties dialogs. Thus, all of
the resistors will use the same temperature coefficients.

This simulation will produce output at the default temperature
setting, 27°C.

Use the
Properties
dialog to enter
the values for
TC1 and TC2
for RMOD. The
dialog will
generate the
RMOD .Model
statement.
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• Set the circuit temperature to 75°C by using the “Circuit
Temperature...” button in the IsSpice4 Simulation Setup
dialog.

The behavior of the entire circuit will be simulated at a
temperature of 75°C. All resistors and active devices in the
circuit will be adjusted, based on the new simulation temperature.

• Uncheck the “Circuit Temperature...” button in the
IsSpice4 Simulation Setup dialog.

• Enter “125” in the Temp field in the Properties dialog of
the QN2219 transistor.

Q10 1 3 0 QN2219 TEMP=125

This will cause the transistor to be simulated at 125°C. The rest
of the circuit will be simulated at room temperature.

The results for the three simulations are shown below.
The temperature set on an active device will override the

Use the
IsSpice4
Simulation
Setup dialog to
set the circuit
temperature.
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temperature set in the .OPTIONS statement. With this feature,
it is easy to simulate a device at one temperature, and the rest
of the circuit at another temperature.

• Set the operating temperature of the circuit to 50°C.

• Simulate the circuit and examine the output.

UIC\IC - Establishing Initial Conditions

In certain circumstances, it is necessary or just convenient to
set the circuit to a particular state prior to the start of a transient
simulation. This is done by setting initial conditions and telling
IsSpice4 to use them.

New Topics Covered
Sources

• IC=...Initial Conditions

Specifications:
Given the circuit shown, we will examine the effect of initial
conditions on the state of the output.

Using Initial Conditions
*#SAVE ALL ALLCUR ALLPOW
.TRAN 1M 1000M
.PRINT TRAN  V(3)
V1 1 0 PULSE 0 10 0 1M 1M 50M 100M
L1 2 3 1M
R2 3 0 10K
R1 1 2 10K
C1 2 0 47U
.END

See the Alter
dialog for more
information on
sweeping the
circuit
temperature.

Open up the drawing at :\spice8\Circuits\Examples\Uic.DWG
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• Simulate the circuit.

Notice that the output voltage requires about 800ms to reach a
steady state value. In some circuits, this may be an obstacle. By
setting the initial conditions of IsSpice4, we can overcome this
initial charge time.

• Enter “2.5” in the IC value field of the capacitor from the
Properties dialog. Then, click on the Transient button
in the IsSpice4 Simulation Setup dialog.

• Check the “Use Initial Conditions” (UIC) check box.
Select OK and Done.

This forces IsSpice4 to start the transient analysis with an initial
voltage of 2.5V on the capacitor. It also eliminates the charge
time and brings the circuit to steady state more quickly.

The results for the two simulations are shown below.

The control
statement, .IC
V(1)=2.5, will
have the same
effect as the
“IC=” on the
capacitor.

The “UIC”
parameter must
be present on
the .TRAN line
in order to
obtain the
proper results.
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The phase
delay
parameter is
available in the
voltage and
current sources’
Tran
Generators
sub-dialog.

Using Phase Delayed Sources

The Sin, Pulse, and FM sources include the ability to add an
initial phase delay at time = 0.

Note: The pulse delay is different from the Td (time delay)
parameter. The Td parameter only delays, in time, the zero
phase version of the pulse waveform.

New Topics Covered

Sources
• Delaying the initial phase of a periodic stimulus

Specifications:
The following statements may be used to generate the waveform
stimulus shown below.

The phase parameter is specified in degrees, and is included at
the end of the statement.

V1 1 0 Pulse(-1 1 0 10U 10U 500U 1M) ; No delay, WFM.1
V2 2 0 Pulse(-1 1 0 10U 10U 500U 1M -270); 270 Degree delay, WFM.2
V3 3 0 Pulse(-1 1 750U 10U 10U 500U 1M) ; Td=750µs, WFM.3
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CHEBYSHEV
*#SAVE ALL ALLCUR ALLPOW
.MODEL S_001 s_xfer(in_offset=0.0 gain=1.0 num_coeff=[1.0]
+ den_coeff=[1.0 1.42562 1.5162] out_ic=0.0 denorm_freq=1.0)
.AC DEC 10 .1 10K
.TRAN .1 10
.PRINT AC  V(2)  VP(2)
.PRINT TRAN  V(2)
A6 1 2 S_001
V1 1 0 PULSE 0 1 AC 1
.END

Using Code Models - Laplace Equations

Code modeling is a new approach to making SPICE models.
The process enables you to add customized C code subroutines
to IsSpice4. The C code describing the model’s behavior is
linked to the simulator via an external DLL file,  rather than being
bound within the executable program. A variety of analog,
digital and mixed analog/digital code models are already
included with IsSpice4. These models behave exactly like
traditional SPICE models, but their model parameters are
configured directly within the schematic, rather than in a separate
library file.

New Topics Covered
Code Models

• Laplace Code Model

Specification:
To understand how to access and work with code models, let’s
experiment with a simple filter circuit using the Laplace code
model. The Laplace code model allows you to enter any
arbitrary s-domain transfer function as a ratio of two polynomials
in s. We will take care of this element in a moment. The voltage
source should have the value of “Pulse 0 1 AC 1” since we will
be running AC and transient analyses. Enter the analysis
statements “.AC DEC 10 .1 1K” and “.TRAN .1 10” in the
IsSpice4 Simulation Setup dialog.

Code Models
can be created
using the
Intusoft Code
Modeling Kit
(CMSDK)

The .SUBCKT netlist does not
have to be typed into IsEd. Use

the Laplace3 symbol.

Open up the
drawing at
:\spice8\
Circuits\
Examples\
Laplaceq.DWG
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Using Code Models
Let’s enter the information to create the 3kHz Chebyshev low
pass filter with the transfer function using the first method.

• Select the X Part...function. From the Browser dialog,
select Behavioral. Then click on the Laplace entry.
Click the Place button.

• Double-click on the Laplace model to enter the
parameter values In the Properties dialog.

• Type in the following parameter values that we will
pass to the Laplace model.

num_coeff=1.0
den_coeff=1.0 1.42562  1.5162
(corresponding to S2=1.0 S1=1.42562 S0=1.5162)
dnorm_freq=1.0

• Close the dialog and run the simulation.
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Code models are more versatile than traditional SPICE models.
SPICE model parameters are generally entered as a single
real-valued number. Code model parameter values can be
integer, real, boolean (True, False), complex, string, vector (a
set of numbers) or an n-dimensional array of values. For
example, the set of denominator coefficients for the Laplace
model comprises a single model parameter.

If desired, you can see how the model is saved in the netlist by
selecting the Edit Text Files Icon from the SpiceNet toolbar.

The results for the AC and transient simulations are shown
below. You can adjust the numerator and denominator
coefficients in the Properties dialog to see different results.
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Note: If you want to use another configuration of the Laplace
model, such as a Laplace equation with a 2nd-order numerator
and 4th-order denominator, you can simply enter a different set
of coefficients.

Accessing Multiple Models
It is not necessary to enter model parameters for every code
model instance unless you want to change the parameters.

• Select the Laplace symbol. Copy and paste another
Laplace symbol.

• Double-click on the second symbol and then open the
Properties dialog. Notice that the parameters for this
symbol are the same as those of the first symbol. Both
symbols will refer to the same models.

Shown next is a circuit for a PID controller that uses the Laplace
and Differentiator code models. The netlist and results are
shown for comparison. Note: a SPICE 2 style Integrator (SINT)
is used in place of a simple Laplace (1/s) block.

PID CONTROLLER
*#SAVE  ALL ALLCUR ALLPOW
.MODEL S_001 s_xfer(in_offset=0.0 gain=2.0 num_coeff=[1.0]
+ den_coeff=[1.0 2.0] denorm_freq=1.0)
.MODEL S_002 s_xfer(in_offset=0.0 gain=10.0 num_coeff=[1.0]
+ den_coeff=[1.0 5.0] denorm_freq=1.0)
.MODEL S_003 s_xfer(in_offset=0.0 gain=1.0 num_coeff=[1.0]
+ den_coeff=[1.0 500.0M] denorm_freq=1.0)
.MODEL DIFF_001 d_dt(out_offset=0.0 gain=1.5 limit_range=1.0u)
.AC DEC 60 .1 100
.TRAN .05 10 0 .05
*INCLUDE SYS.LIB
*INCLUDE CM1.LIB
*#ALIAS  V_P  V(7)
*#ALIAS  VOUT V(10)
*#ALIAS  V_I  V(4)
.PRINT AC  V(7)  VP(7)  V(10)  VP(10)
.PRINT AC  V(5)  VP(5)  V(4)  VP(4)
.PRINT TRAN  V(7)  V(10)  V(5)  V(4)
.PRINT TRAN  V(9)
X8 9 10 6 SUM2 {K1=1 K2=-1 }
V1 9 0 AC 1 PULSE 0 1 .5

A4 1 3 S_001
A6 3  10 S_002
A7 2 1 S_003
X9 6 7 GAIN {K=.8 }
X10 6 4 SINT {K=.5 }
A8 6 5 DIFF_001
X6 7 4 5 2 SUM3 {K1=1 K2=1 K3=1 }
.END

Open up the
drawing at
:\spice8\
Circuits\
Examples\
PIDController.DWG
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Table Model Transfer Functions

IsSpice4 allows you to specify arbitrary transfer functions using
tables of X, Y points. This is accomplished with the PWL
(piecewise linear) code model, which is often called a Table
model.

New Topics Covered

Code Models
• Table Code Model
• Entering Vector Model Parameters

Specification:
Enter the circuit as shown below. The code model can be
selected from the Parts Browse dialog under the Behavioral
Type, Function subtype. The model parameters for the Table
model are entered in the Properties dialog. Let’s enter the data
for the Table model.

• Double-click on the Table symbol.

A table model’s input/output relationship is described by a
series of X, Y, data points. There are 4 pairs in this case, with
the output linearly interpolated between points.

• Enter the data points listed below in the PWL_001
model into the xy_array field.

Note: To enter
the proper
values for the
Laplace model,
use the Laplace
Properties
dialog.

The model parameters listed in each
code model, and the parameters
passed to Sum2, Sum3, Gain and SINT,
must be entered into the Properties
dialog of each element.

Open up the
drawing at
:\spice8\
Circuits\
Examples\
Table.DWG
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Notice that the transfer function continues past 20, using the
slope that was established by the highest two points.

TABLE Test Circuit
*#SAVE ALL ALLCUR ALLPOW
.MODEL PWL_001  Pwl(xy_array=[0  0    5  10    10  2    20  0]
+ input_domain=10m fraction=true)
.TRAN 1 25
A3 1 2 PWL_001
V1 1 0 PULSE 0 25 0 25
.END

Using Table Models From Other SPICE programs
Other SPICE programs may use a similar format for table-type
models. If the data points are in an X,Y sequence, you can
simplify the process via the following:

• Using any Windows text editor, copy the points from the
existing netlist to the clipboard using (<Ctrl>+ C).

• Switch programs to SpiceNet.
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The default
resistance
values for the
switch model
are: RON=1W
and
ROFF=1E12W

• In the PWL Properties dialog, you can paste in the data
points by  pressing (<Ctrl>+ V) in the xy_array=[ ....]
parameter field.

Switches - A Comparator With Hysteresis

In this example, we will repeat a prior example using a switch.

New Topics Covered
Primitive Element

• S...Voltage Controlled Switch

Specifications
We will construct a model of a comparator with hysteresis. As
in the previous example, the on state will occur when the input
voltage difference is greater than zero, and the off state will
occur for every other value. Be sure to create a comparator
symbol as stated in the previous comparator example.

• Construct and simulate the circuit using a netlist
approach as shown below.

Switches - A Comparator With Hysteresis
*#SAVE ALL ALLCUR ALLPOW
.TRAN 1U 200U
.PRINT TRAN  V(1)  V(4)
V1 1 0 PWL 0 0 100U 1 200U 0
V2 2 0 .5
R1 4 3 5.1K
V3 3 0 15
X1 2 1 4 COMPAR
.SUBCKT COMPAR 1 2 3
S1 3 0 2 1 SWMOD
.MODEL SWMOD SW(RON=.5
+ ROFF=10G VT=.2 VH=.1)
.ENDS
.END

Open up the
drawing at
:\spice8\
Circuits\
Examples\
Switches.DWG
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As you can see, a different approach was used for this
comparator. The switch model in IsSpice4 is used because it
contains parameters to model hysteresis. Since the hysteresis
is built into the switch model, the construction of a comparator
with hysteresis becomes quite easy.

The .MODEL statement for the switch specifies a threshold
voltage of 0.2 volts. This means that as soon as the difference
between the inputs exceeds 0.2 volts, the switch will change
state. The parameters RON and ROFF specify the on/off
resistance levels of the switch. In this case, when the switch
triggers, the output will change to a low resistance state, .5W.
When the switch is off, the output will be in a high resistance
state, 10GW. The hysteresis is specified by the VH parameter.
With hysteresis, the comparator will be on at a voltage of .8V
(Vref+VT+VH) and off at a voltage of .6V (Vref+VT-VH). Since
the output in this example changes between a high resistance
state and a low resistance state, the comparator simulates an
open collector output stage. The results of the simulation are
shown below.

Current
controlled
switches are
also available in
IsSpice4.
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Analog-Digital Interfacing

The purpose of this example is to introduce node translation.
Node translation is performed throughout the remaining
examples in this chapter. It is an important concept when
dealing with mixed-mode circuits.

New Topics Covered
Code Models

• Inverter Code Model
• Hybrid Code Models
• Configuring Code Models

Specification:
A transient analysis will be performed on a simple inverter
circuit. A 500kHz square wave (V1, Pulse source), with 10ns
rise and fall times, will be used as the input. Input and output
node data will be collected for 10us, in 10ns steps. The rise
and fall times of the D-to-A node bridge will be set to 100ns.
The rise and fall delays of the inverter will be set to 500ns.
Delays in the Analog-to-Digital (A-to-D bridge) will be set to a
negligibly small value of 1ps.

Digital/Mixed Mode Examples

For the
purposes of
these
examples,  A2D
and/or D2A
bridges are
used to
interface analog
nodes with
digital nodes.
These bridges
are not
required; if they
are not present,
the software will
automatically
insert them in
the netlist file,
as necessary.
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The A-to-D and
D-to-A node
bridges use the
A2D and D2A
symbols,
respectively.

Node Translation Using Hybrids

• Double-click on the voltage source then double-click
on “None” in the Tran Generators option to enter the
following values.

Placing and Configuring The Code Models
From the Part Browser dialog, place the symbols as shown
above. The inverter is located in the Digital Part types. The A2D
and D2A bridges are located under the Bridges Part Type.

• After the parts are placed, double-click on the A2D
symbol to open the Part dialog.

• Then click on the appropriate fields to enter the new
parameter values.
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• Repeat these steps for the D2A and inverter symbols.
Their parameter values are shown below.



176

Node Translation (with Node Bridges)
Node translation is required whenever any non-analog
component is used in a simulation. Node bridge elements are
used to perform the translation between different types of
signals (Analog, Digital, Sampled-Data and Arrays) and to
obtain output waveforms for any non-analog node. For analog
and digital parts, specifically, an A2D bridge translates analog
signals to digital states, while a D2A bridge translates digital
states to analog voltages. For this simple example, two node
translations are required. The first translates the analog input
pulse from a voltage source into a digital signal that is used to
drive the inverter. The second translates the digital output state
of the inverter into an analog voltage so that the signal can be
viewed in real-time and displayed in IntuScope.

A-to-Ds and D-to-As are not bidirectional. You cannot connect
a D-to-A backwards to get an A-to-D. In the figure to the left,
notice that the A-to-D has been flipped in an attempt to make
a D-to-A.

The arrow shown inside the symbol marks the correct conversion
direction. The A-to-D must have an analog signal connected to
its input, and a digital signal connected to its output. The
opposite is true for the D-to-A.

Correct

Incorrect



177

DIGITAL/MIXED-MODE SIMULATION EXAMPLES

Binary Counter

In the previous example, we focused on the important concept
of node translation. In this example, we will introduce a more
complex digital circuit.

New Topics Covered

Code Models
• SR flip-flop Code Model
• Analog/Digital ground
• Initializing flip-flops

Specification:
The eight-state binary counter (shown below) will be simulated.
The counter will be clocked at a frequency of 20MEG Hz (rise
and fall times are set to 1ns). The counter will be initialized to
a zero output state. Data will be collected for the input clock and
all three outputs for 500ns, in 1ns intervals. All rise and fall
delays will be set to 1ns.

Binary Counter
.TRAN 1N 500N
*#ALIAS  V2  V(1)
*#ALIAS  V0  V(3)
*#ALIAS  V1  V(4)
*#ALIAS  VCLK  V(8)
V3 6 0 PULSE 5 0 1N
A4 [8] [2] A2D   ; from the Bridges Part Type
A5 [20] [3] D2A ; from the Bridges Part Type
A6 [13] [4] D2A
A8 [6] [15] A2D
A10 [17] [1] D2A
A11 9 PDOWN ; from the Digital Part Type
A13 14 20 2 9 15 20 14 SRFF ; from the Digital Part Type
A14 5 13 14 9 15 13 5 SRFF
A15 10 17 5 9 15 17 10 SRFF
V1 8 0 PULSE 0 1 0 1N 1N 25N 50N
.END

Open up the
drawing at
:\spice8\
Circuits\
Examples\
Bincntr.DWG



178

in_high =900m out_high =1
rise_delay =1p out_undef =500m
fall_delay =1n t_rise =1n

    t_fall =1n

The SRFF Model:
 clock_delay =1n rise_delay =1n
 set_delay =1n fall_delay =1n
reset_delay =1n sr_load =1p
output initial state =0 CLKL = clk_load =1p
SL = set_load =1p RSL = reset_load =1p

The Pdown Model:
load = 1p

The Pulse stimulus parameters, which define the voltage
sources V1 and V3, are located in the netlist.

Placing parts and Configuring the Code Models
The SR flip-flop and pulldown code models are located in the
Browser dialog under the Digital Type, with Generic Subtype as
SRFF. The A2D and D2A parts are located under the Bridges
Type.

• Place the parts as shown above. Double-click on each
part and configure the model according to the values
given below.

The A2D Model: The D2A Model:
in_low =100m out_low =0
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Ground and The Pulldown Code Model
The pulldown code model is equivalent to a logic 0, or digital
ground. It is used here to avoid placing a D2A between the
preset and ground (the pullup is used to provide a logic 1).

Initializing the Flip-Flop
The pulldown code model is used to pull the preset of all the flip-
flops low. The voltage source, V3, is used to clear all the flip-
flops. The PULSE statement (used for V3) places a high at the
Clr input during the first clock transition (time=0). Hence, the
outputs are low until the next positive edge at time=50n. This is
the preferred method for initializing flip-flops. Alternatively, the
SR flip-flop code model has an “ic” model parameter that can
be used to initialize the outputs of the flip-flop. If a pulldown code
model is placed on the Clr and Pr inputs, the “ic” model
parameter will be used to initialize the code model (0=low,
1=high, 2=unknown). The resulting waveforms would be the
same, but the count would start at the first clock transition
located at time=0. The output for this example is shown below.
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State Machine

In this example, we will demonstrate the use of the state
machine by duplicating the previous binary counter example.
The state machine is quite useful since the state diagram, or
state table, of a counter is available before the circuit is
constructed. In fact, the state machine can be used to replace
any large section of clocked combinational digital circuitry.

New Topics Covered
Code Models

• State Machine Code Model

Specification:
The binary counter from the previous example is shown below,
which uses the state machine code model. All input and output
conditions will be the same as the previous example.

All devices,
except the state
machine, are
given the same
parameters as
in the previous
example.
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A2D V02

Open up the
drawing at
:\spice8\
Circuits\
Examples\
Statemch.DWG
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Placing Parts
All devices, except the state machine, are given the same
parameters as in the previous example. The state machine for
this example is located in the Digital Type, Generic Subtype as
BCNT in the parts list of the Parts Browser dialog. The Properties
dialog for the state machine is given below.

State Machine Symbols and Models
The state machine code model can have a variable number of
inputs and outputs, and an unlimited number of states. Typically,
your state machine will start as a state diagram. From this
diagram, the state transition table for the state machine code
model will be created. The format for this file is given in the
IsSpice4 User’s Guide. Below is a state transition file
(BCNT.TXT) for this example. The state machine’s .model
statement contains a parameter called state_file. Its value is a
filename that contains the state transition information, in this
case, BCNT.TXT. You can only change this data by editing the
BCNT file.

For other state machine configurations you will have to create
a new library entry like the BCNT one in the CM2.LIB file, a  new
symbol, and a new state transition file like BCNT.TXT

Note: You must copy the BCNT.TXT file to the directory where
the circuit file is located. The state machine looks for the state
transition file in the project directory.

Note: The state
machine model
and state
transition file
must be
reconfigured for
each different
state machine.
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****
0 0s 0s 0s 0 -> 1
           1 -> 1

1 0s 0s 1z 0 -> 2
           1 -> 2

2 0s 1z 0s 0 -> 3
           1 -> 3

3 0s 1z 1z 0 -> 4
           1 -> 4

4 1z 0s 0s 0 -> 5
           1 -> 5

5 1z 0s 1z 0 -> 6
           1 -> 6

6 1z 1z 0s 0 -> 7
           1 -> 7

7 1z 1z 1z 0 -> 0
           1 -> 0

The first column defines the state. The next three columns
define the output for the state. The fifth column, which precedes
the -> symbol, defines the expected input. The final column,
after the ->, defines the state that is expected if the input is
present during the positive edge of the input clock signal. You
can see from the file that the output is a binary counter that
changes state on either a high or low input.

Once the state transition file is created, a symbol can be
constructed to match the desired number of inputs and outputs.

In this case, the part has the pin order:

A47 [1] 3   4    [11 6 5] St3
*   In  Clk Clr Out2 1 0

State Transition
File for the state
machine used in

the Binary Counter
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The process of adding a new model library entry is covered in
the on-line help.

The output for this example is shown below.
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Boolean Logic Functions

Apart from the digital simulation capabilities of IsSpice4, an
extremely useful feature is the ability to enter Boolean logic
expressions. As with the state machine code model, this
function can greatly speed the implementation of digital circuitry.
Boolean functions are accessed through the B (arbitrary
dependent source) element. Boolean logic is faster and more
efficient than event-driven elements for most simple logic
functions, which only require a few gates.

This example is split into two parts. First, we will introduce the
Boolean expression simulation using a simple NAND gate and
a simple NOR gate. Second, we will implement a larger Boolean
expression.

New Topics Covered
Sources

• B...Nonlinear Dependent Source
• Boolean Expressions
• .OPTIONS...LTHRESH, LONE, LZERO

Specifications:
We will use the B element to construct a typical AND-NOR
stage. The gates will be represented by a single Boolean
expression.

NAND and NOR Gates
The syntax for the B source is listed in the IsSpice4 User’s
Guide. The &, |, and ~ operators will be used to construct a
NAND gate and a NOR gate.

To implement an AND function, first AND two voltages:

V(1) & V(2)

To create the NAND, NOT this combination:

~(V(1) & V(2))

Open up the
drawing at
:\spice8\
Circuits\
Examples\
logic.DWG
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To implement a NOR function, first OR the voltages,

V(1) | V(2)

Then, to create the NOR, NOT this combination:

~(V(1) | V(2))

The phrase
“~(V(1)&V(2))“
is entered into
the B element
Properties
dialog in the
Expression
window.

To enter an expression:

• Double Click the arbitrary dependent voltage source
B to open up the Behavioral Properties dialog.

• Enter an expression in the Expression field.
• Or, click on the Enter button in the dialog and type.

Enter the
expression
in either field
here.

NAND Gate
.TRAN 1U 2.5M
BNAND 3 0 V=~(V(1)&V(2))
V1 1 0 PULSE 0 5 0 1U 1U 100U 200U
V2 2 0 PULSE 0 5 0 1U 1U 200U 400U
.END

1

V1

Vin1
volts

2

V2

Vin2
volts

3

B1
Voltage

Vout
volts
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• Construct and simulate the NAND circuit. Notice how
the voltage sources and the B element are not wired
together. When the simulation is complete, examine
the output.

Note the spike in the NAND output (waveform 3). This occurs
because the TRISE and TFALL values of the inputs are equal
to the TSTEP value. This causes the input signals to cross at
2.5V. At the TSTEP time, both signals are above the Lthresh
level (1.5V), therefore generating the spike in the output
(waveform 3). Such conditions are possible because Boolean
functions are continuously evaluated.Default

.OPTIONS
parameters for
Boolean
expressions
are:
LTHRESH=1.5V
LONE=3.5V
LZERO=.5V

Input V(2)

Input V(1)

Spike

Output v(3)

V(2)

V(1)
TSTEP Time

Expanded view
of NAND

waveforms
at the spike timeLthresh=1.5V

2.5V

Boolean
functions are
continuously
evaluated, not
event-driven.

NAND
Simulation
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NOR Gate
.TRAN 1U 2.5M
BNOR 3 0 V=~(V(1)|V(2))
C1 3 0 0.87NF
V1 1 0 PULSE 0 5 0 1U 1U 100U 200U
V2 2 0 PULSE 0 5 0 1U 1U 200U 400U
.END

• Construct and simulate the NOR circuit. You can do
this by simply modifying the NAND circuit.

The B element has no physical nodal input connections. Its only
input comes from the variable listed in the Boolean equation
that was entered into the Properties Expression field.

The .OPTIONS parameters, LTHRESH, LONE and LZERO
control the turn-on/turn-off voltage threshold, the high level
output and low level output, respectively.
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• Set the low level output to 0V, the high level output to
5V and the threshold to 0.1V by typing the following
.OPTIONS line in the IsSpice4 Simulation Setup dialog.
Type this in the User Statements area.

.OPTIONS LTHRESH=.1  LONE=5 LZERO=0

More Complicated Boolean Expression
To demonstrate the power of the Boolean expression, we can
implement the stage shown below with one expression.

V(Out) = ~( (V(A)&V(B)) | (V(C)&V(D)) )

A subcircuit could be made by implementing this gate
combination. It may be called as many times as needed without
being retyped. The subcircuit would be:

.SUBCKT ANDNOR 1 2 3 4 5
b1 5 0 v=~( (v(1)&v(2)) | (v(3)&v(4)) )
.ENDS

• Enter and simulate the following netlist. Examine the
output and verify the operation of the subcircuit.

Boolean Logic Expressions
.TRAN 1U 500U
VA 1 0 PULSE 0 5 0 1U 1U 10U 20U
VB 2 0 PULSE 0 5 0 1U 1U 20U 40U
VC 3 0 PULSE 0 5 0 1U 1U 40U 80U
VD 4 0 PULSE 0 5 0 1U 1U 80U 160U
X1 1 2 3 4 5 ANDNOR
.SUBCKT ANDNOR 1 2 3 4 5
B1 5 0 V=~((V(1)&V(2))|(V(3)&V(4)))
.ENDS
.END

○ ○ ○ ○
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If-Then-Else - An A to D Converter

In this example, we will use the if-then-else capability to
simulate an analog-to-digital converter.

Specification:
Below is a circuit file that implements an 8-bit A-to-D converter.
The input stimulus is a ramp voltage created by the PULSE
statement given by vin. The ramp will cause the A-to-D converter
to cycle through all of its states. The A-to-D converter consists
of one stage per bit. Each stage is identical and is represented
by the subcircuit “adc,” as shown in the netlist. In this subcircuit,
B1 is used to limit the “bin” value to 1 or 0, thus producing the
digital output. B2 is used to conditionally subtract the reference
(1 volt) from the input. The resultant error signal is then
multiplied by two, so that it can be applied to the input of the
following stage of the A-to-D converter.

• Construct and simulate the circuit shown below. You
will need to construct an ADC symbol.

An A to D converter
.tran 100n 1u 0 1n
vin 1 0 pulse 0 2 0 1u 0 1u
x1 1 2 10 adc
x2 2 3 11 adc
x3 3 4 12 adc
x4 4 5 13 adc
x5 5 6 14 adc
x6 6 7 15 adc
x7 7 8 16 adc
x8 8 9 17 adc
.print tran v(10) v(11) v(12) v(13)
.print tran  v(14) v(15) v(16) v(17)
.print tran v(1) v(2) v(3) v(4)
.print tran  v(5) v(6) v(7) v(8)
.subckt adc in out bin
b1 bin 0 v= (v(in) > 1) ? 1 : 0
b2 out 0 v= 2*(v(in) - v(bin))
.ends
.end

In

bin

Out

In

bin

Out

Example adc symbols
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MIDI Synthesizer

In this example, we will simulate a MIDI synthesizer in order to
examine the  mixed-domain simulation capability of ICAPS.
The MIDI circuit uses three types of data: Digital, Real and
Analog. These types are signified by the letters D, R and A,
respectively on the schematic. Translational node bridges are
used to convert between signal types.

New Topics Covered
Sources

• Digital Source
Code Models

• Numerically Controlled Oscillator (NCO)
• Digital Frequency Divider
• Sample Data Filter using Real Gain and Real Delay
• Limiter

Specifications:
Given the circuit shown below, we will perform a transient
simulation and collect data every 0.1ms for 200ms at the output
(node 13) and for the digital clock signal (node 17). Reltol,
which is entered in the Simulator Options menu of the IsSpice4
Simulation Setup dialog, should be set to .0001.

R  A  

6 1
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Midi
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MIDI
.OPTIONS RELTOL=.0001 ; Simulation Options... dialog
.MODEL DS7_001 d_source(input_file=source7.txt input_load=1.0p)
.MODEL FDIV_001 d_fdiv(div_factor=8 high_cycles=4
+ i_count=0 rise_delay=2.0N fall_delay=20.0N freq_in_load=1.0p)
.MODEL A2D_001 adc_bridge(in_low=100M in_high=900.0M
+ rise_delay=1.0N fall_delay=1.0N)
.MODEL D2R_001 d_to_real(zero=0.0 one=1.0 delay=1.0N)
.MODEL R2A_001 real_to_v(gain=1.0 transition_time=1.0N)
.MODEL MIDI_001 nco(delay=1.0N mult_factor=16.0)
.MODEL LIM_001 limit(in_offset=0.0 gain=300.0k out_lower_limit=-12.0
+ out_upper_limit=12.0 limit=12.0 limit_range=1.0u fraction=FALSE)
.MODEL D2A_001 dac_bridge(out_low=0.0 out_high=1.0 out_undef=500m
+ t_rise=1.0N t_fall=1.0N)
.TRAN .0001 .2
*#ALIAS  VOUT  V(13)
.PRINT TRAN  V(13)
A2 [1 2 3 4 5 6 7] 11Midi_001
A4 16 15 10 D2R_001
X1 10 11 8 DIG_FILTER
R1 14 12 2K
R2 12 0 300K
R3 12 13 1K
C1 12 13 .5U
A6 8 14 R2A_001
A9 11 16 FDIV_001
V1 9 0 PWL 0 1 .049 1 .05 0 .074 0 .075 1 .109 1 .11 0 .139 0
+ .14 1 .159 1 .16 0
A11[ 9] [15] A2D_001
A12 [11] [17] D2A_001
A13 12 13 LIM_001
A1 [1 2 3 4 5 6 7] DS7_001
.END

Placing Parts
The digital source used for this example can be found under the
Digital type, Generic Subtype as Dsrc7. The MIDI VCO and
frequency divider models are also found under the Digital type,
Generic Subtype as NCO and Fdiv, respectively. The sampled
data filter and the limiter can be found under the Behavioral
Type, Function Block subtype as Dig_Filter, and Limitc,
respectively. All node bridges (D-to-A, A-to-D, D-to-R, and R-
to-A) are found under Bridges Type. The parameters used to
configure the code models can be found in the netlist given
above.
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Digital Source
The MIDI note data is created using a digital stimulus source,
Dsrc7. MIDI notes are composed of 7 bits, and are numbered
between zero and 127 (Bit 1 = MSB). Three C notes are
simulated, each an octave apart, corresponding to the note
numbers 60, 36 and 48. These are given by the following digital
source input file, MIDI.txt.

*T 1 2 3 4 5 6 7
*i
*m
*e

0 0s 1s 1s 1s 1s 0s 0s
.06 0s 1s 0s 0s 1s 0s 0s
.12 0s 1s 1s 0s 0s 0s 0s

The digital values, 0s and 1s, correspond to the acceptable
state values as defined in the IsSpice4 User’s Guide. Please
refer to this guide for a more complete description of the defined
states and the digital source syntax.

Numerically Controlled Oscillator (NCO)
The MIDI VCO (NCO model) is a digitally controlled oscillator
that produces a square wave with a frequency based on the
MIDI note number presented at the input. The digital input
source feeds this model to create the desired digital frequency.
The frequency multiplier model parameter (mult_factor) is 16.

Frequency Divider
The frequency divider is a generic divide-by-N frequency
divider. The model parameter (div_factor) defines the value of
N. In this example, the output from the NCO is divided by 8 and
fed to the sampled data filter.

Sampled Data Filter
The sampled data filter is a subcircuit composed of real gain
and real delay (Z-1) code models, as shown below. These
models use real data, and therefore require node bridges on
the input and output to convert from digital to real and from real
to analog.

MIDI.TXT is an
external text file
that contains a
description of
the digital
source.

Note: You must
copy the
MIDI.TXT file to
the directory
where the MIDI
design is
located in order
to make it
accessible. The
digital source
looks for the
source input file
in the project
directory.
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The input is translated from a digital state to a real value using
the D-to-R node bridge. The enable on the D-to-R bridge is
driven by a simple PWL statement, which is converted to a
digital signal with an A-to-D bridge. The output is converted to
an analog signal through a real-to-analog bridge. The subcircuit
for the sampled-data filter can be viewed in the IsSpice4 .OUT
output file.
  
Limiter
The limiter code model is a simple limiting gain stage. In this
example , the limiter is used  to simulate the lowpass filter output
stage. The final limiter output is shown below.

A detailed description of the MIDI synthesizer is located in the
November 1994 Intusoft Newsletter.

Note: In order
to view the
digital output, a
D-to-A bridge
was required to
convert the
digital clock
signal to its
analog
equivalent.
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HOT KEY REFERENCE GUIDE

IntuScope5 Hot Key Table

Function Letter

add +
Add Waveform Ctrl+F
average a
Bode with margins b
Clear Del
Close Graph Ctrl+W
Context Help Shift+F1
Copy Ctrl+C
Cut Ctrl+X
Data points #
Differentiate d
divide /
Do Command Script Ctrl+R
efficiency e
enlarge Shift+Up
Exit/Quit Ctrl+Q
expandx x
expandy Y
FFT time to mag f
frequency w
Get X at Cursor 0 F7
Get X at Cursor 1 F8
Get X Delta F10
Get Y at Cursor 0 F5
Get Y at Cursor 1 F6
Get Y Delta F9
Integrate i
matchscales y
maximum >

Hot Key Table
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IntuScope5 Hot Key Table

Function Letter
minimum <
Move Cursor 0 <- to a(y) F11
Move Cursor 0 -> to a(y) F12
Move Cursor 0 to X F3
Move Cursor 1 <- to a(y) <-
Move Cursor 1 -> to a(y) ->
Move Cursor 1 to X F4
multiply *
New Graph Ctrl+N
nudgedown Down
nudgeup Up
Nyquist n
Open Graph... Ctrl+O
Paste Ctrl+V
peak to peak p
Print... Ctrl+P
Redo Shift+Ctrl+Z
Reset Cursors HOME
RMS r
Save Graph Ctrl+S
Scaling Ctrl+L
Scaling Dialog Ctrl+L
Schematic Ctrl+D
Select All Ctrl+A
Show Cursor Bar Ctrl+K
Show Script Windows Ctrl+J
shrink Shift+Down
Simulate Ctrl+G
Std Deviation $
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IntuScope5 Hot Key Table

Function Letter
subtract -
superfamily s
Text Edit>Input Ctrl+I
Tile All Traces(y only) Ctrl+T
Undo Ctrl+Z
Update Using Selected Mode Ctrl+U
X at Maximum M
X at Minimum m

IsSpice4Hot Key Table

Function Letter

Copy Ctrl+C
Cut Ctrl+X
Exit/Quit Ctrl+Q
Print Ctrl+P
Undo Ctrl+Z
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SpiceNet Hot Key Table

Function Letter
Amps —> Amps control source F
Amps —> Volts control source H
Arbitrary Iout control source 2B
Arbitrary Vout control source B
Bus 2W
Capacitor C
Continuation Z
Current source I
Current test point 3Y
Cut Ctrl+X
DC voltage source V
Differential voltage test point 2Y
Diode D
Ground O
Ideal T line T
Inductor L
Mutual Inductor K
N-BJT Q
N-JFET J
N-MFET 4Z
N-MOS M
P-BJT 2Q
P-JFET 2J
P-MFET 5Z
P-MOS 2M
Power test point 4Y
RCRD Lossy T Line U
Resistor R
RLCG Lossy T Line 4O
Run a simulation Ctrl+G
Switch I control 4W
Switch V control S
Voltage test point Y
Volts —> Amps control source G
Volts —> Volts control source E
Wire W
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Index
Symbols
.AC 133
.END 14
.ENDS 146
.MODEL

Diode 134
JFET 138
MESFET 157
resistors 160
switch 172

.OPTIONS 159, 186
scaling waveforms 89

.PRINT 89
current 139
device parameters 157

.SUBCKT 146

.VIEW 89

A
A-to-D converter 189
AC Analysis

dialog 61
AC analysis

example 127
AC frequency sweep 62
Accumulate Plots

example 93
Accumulator Window 98
accuracy 130
active analysis 66, 90
Add to Bus function 28
adding part values 18
After Simulation Go To 64
alias 53, 89
aliasing, data 135
Alter dialog 73
Alter function 71
Alter tool 71
AM 152
Analog-to-Digital Interfacing 173

analysis 93
Analysis Wizard 57, 59
array

model parameter 167
arrow

4-way 19
Arrow Heads 45
artwork shapes 44
AtoD 173
attributes 14

schematic 31

B
B 152, 154
binary counter 177, 180
Bode Plot 127, 128
boolean 167

model parameter 167
Boolean Expression 188
Boolean Logic Functions 184

.OPTIONS, LTHRESH, LONE,
LZERO 184

B Nonlinear Dependent
Sources 184

expressions 184
bridges 190
Buffering 141
Bus Rules 27
Bus Tool 19
Busses

non-orthogonal 27

C
change node numbers 18
changing component values 92
changing projects 17
characteristic impedance 141, 144
Chebyshev 166
Circuit Temperature 75
code modeling 165
Code Models
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Analog/Digital ground 177
Digital Frequency Divider 190
Initializing flip-flops 177
Limiter 190
placing and configuring 174
Sample Data Filter using Real

Gain, Real Delay 190
SR flip-flop 177
State Machine 180

code models 177
accessing 168
CML.DLL 165
d_fdiv 190, 192
d_pulldown 177
d_source 190
d_srff 177
d_state 180
Laplace 165
limit 190
nco 190, 192
real 190

Commands Window 98, 110, 122
comparator 154

with Hysteresis 171
complex

model parameter 167
component

selecting 23
semiconductor 137

configurations
multiple 37
scroll list 36
simulation setup 36
test 80

Configurations function 82
Configuring Code Models 173
connecting parts 26
connectivity 14
control statements 14
Copy to Clipboard button 114

copying objects 19
counter 177, 180
cross-probe 64

tool 69
cross-probing

AC magnitude and phase
waveforms 70

AC voltage 66
current 66
IntuScope 69
power dissipation 67
schematic 65
voltage 65

crosshair symbol 20
curly braces 78
current

Measurement 139
current or power waveform

saving 68
cursor

pan 19
Cursor Control Bar 106
curve family 75

D
D 137
D-to-A 173
d_fdiv 190
d_source 190
d_state 180
Darlington PNP-NPN 77
data

aliasing 129, 135
current measurement 139
delayed accumulation 159
internal timestep 130
past simulations 93
Pole-Zero 133
RELTOL 131
sampling 129, 136
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Data Printout Step 57
Data Step Time 60
DC Analysis 139
decade 62
Decade button 61
delay 164
deleting objects 19
deluxe option 8
device characteristics 138
device/model parameters 158
Devices

semiconductor 137
differentiator 168
digital gates 184

timestep control 186
digital ground 177, 179
digital source 190
diode 134
display

ICL command 93
displaying node voltages 83
DLL 165
DoScript button 92, 93, 95
Drawing Artwork Shapes 44
Drawing Item Colors 41, 42

E
Edit Configurations dialog 37
Edit: field 95
equations 74, 152
error tolerance 131
errors and status 88
example

schematic panning 19

F
FFT 153
file menu 15
Fill Type 45
filter 190, 192, 193

fit screen 25
Fit to Screen 19
flip-flop 177
flipping a symbol 19
FM

delay 164
frequency divider 190, 192
function keys 25

G
GaAs 157
generic subcircuits 78

user-defined parameters 79
Global Colors function 41
ground 14
ground symbol

placing 19, 47

H
hardware requirements 8
help pop-up

SpiceNet 35
Hybrid Code Models 173
hysteresis 171

I
IC 162
ICAP_4

program group 13
ICL 91

Introduction 91
If-Then-Else 154, 189
Imaginary 146
Impedance Matching 142
In-line Equations 152
Initial Conditions 162
input netlist 35
insertion point 52
installing 10
integer



202

model parameter 167
internal timestep 130
IntuScope

Active IsSpice Simulation 100
Active Project .OUT file 102
Active Project Output File 100
Add Waveform Dialog 101, 103
Commands Window 110, 122
copy to clipboard 114
copying a waveform 105
Cursor Control Bar 106
customizing toolbar 113
deleting a waveform 105
Help Menu 99
hiding a waveform 107
Interactive Control Language

(ICL) 110
interpolated (resampled)

data 102
IsSpice WFMS... 128
labeling values 109
Load Script 110
non-interpolated (raw) data 102
obtaining data from a vector

set 101
opening a new graph window 99
print preview 113
renaming a plot 105
scaling a waveform 108
Scaling dialog 108
Scripts 123
selecting a waveform 107
separating waveforms 103
Smith Charts 114
starting 97
TwoPort Networks 116
types of waveform data 99
updating a waveform 111

Inverter Code Models 173
Iscale 89

IsSpice WFMS... 128
IsSpice4

control statements 14
display 88
output window 88
primitive elements 78
Requirements 14
screen display 88
simulation requirements 56
starting 87

IsSpice4 Control Statements 35, 56
multiple sets 36

IsSpice4 Simulation
screen 63
Setup dialog 35, 37, 62

J
J 137
JFET 138

K
Keyboard

function table 18

L
Label Style 32
labeling parts 31
Laplace model 165
layers

schematic 76
Library Manager 117
limit 190
linear sweep 72
Logscale 89
LONE 186
LTHRESH 186
Lthresh 186
LTRA 143
LZERO 186
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M
M 137
Macro Modeling 149
magnetics 149

saturation 151
magnifying glass symbol 71
Magnitude 135, 147
Make Breakout 28
Math 152
memory use 94
MESFET 157
MIDI 190
MIDI oscillator 192
Minimum Printing Line Width 43
model parameter

code models 167
models 165

code 165
Modulator 152
mouse

function table 18
using, schematic 18

moving
an object 18
symbols 25

multiple
configurations 37
schematic pages 29, 30

N
NAND 184
NAND circuit 186, 187
nco 190
netlist

requirements 14
NetList Edit function 33
netlist requirements 14
new layer

creating 76
Next Part button 32, 33, 52
node

numbers 26, 77
changing 18

Node bridge elements 176
Node Translation 176, 190
Node Translation using Hybrids 174
node voltages

deleting 83
displaying 83

Node: field 90
nonlinear dependent source 152, 154
NOR 184
NOR circuit 187
Normal function 71
Numerically Code Models

Numerically Controlled
Oscillator 190

Nyquist 129, 136

O
opening a project 15
operating point 95

information 84
operating point values

deleting 83
operating point voltages

displaying 83
output

control statements 14
DC 140
device/model 157
FFT 153
Pole Zero 133
transient 130

Output window 88, 98
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P
pan cursor 19
Panning 19
parametric

sweeping running 71, 74
part values

adding 18
Parts menu 47
phase delay 164
phase velocity 144
PID controller 168
piece-wise linear 127
pins 26
placing components 47, 48
placing parts 21
Plot List 72
plot name 93
Plots pop-up 93, 94
pointer box 18
Pole-Zero 127, 131, 133
power 14
Prev Part button 32, 33
primitive elements 78
print

preview mode 43
print expressions

example 89
printing

schematics 43
VDB 89

Probe
Icon 65
Symbol 65
Tool 65

project
changing 17
opening 15

Properties dialog 31
Pspice

table models 170

pulse
delay 164

PWL 127, 128
PZ 127

Q
Q 137

R
real 146, 167

model parameter 167
real code models 190, 192, 193
real delay 192, 193
real gain 192, 193
Real Time display 53
real time display 88, 89
real time waveforms 89

adding/deleting 90
Ref Des Reassign 55
Ref Des retained 54
reference designations 14
reference designators 77
RELTOL 130, 131
requirements 8

netlist 14
software/hardware 8

rescale
real time waveforms 89

resistor
equations 74

RLC circuit 52, 76
RLC circuit output 72
rotating a symbol 19
Rubberbanding 26
Run button 72, 75
running a simulation 16, 63, 81
Running a Temperature Sweep 74

S
s_xfer 165, 168
Sample circuit 16



INDEX

205

sampled data filter 192
sampling 129, 136
Saturable Core 149
Save Data 62
Save function 52
save, ICL command

example 89
Save icon 52
saving a schematic 52
saving simulation data 93
scaling

real time waveforms 89
Scaling dialog 108
schematic

layers 76
mouse usage 18
moving an object 18
multiple pages 29, 30
panning 18, 19
zooming 18, 20

Script Atoms 94
script field 91
scripts

alter example 92
example 91

semiconductor
JFET 139
proper use 137

show
example 95

Show Border
check box 39

showmod
example 95

Simulate function 63, 82
simulation

accuracy 130
running 16, 63, 81
temperature 159
time step control 127

viewing past data 93
Simulation Control dialog 88, 91

definition 90
DoScript button 92

simulation options
activating/deactivating 62

Simulation Setup 14
Simulation Setup icon 35, 56
simulation sweep

running 72, 75
SIN 134
Smith Chart 114
software

requirements 8
SpiceNet

exiting 17
quitting 17
symbol attributes 31

state machine 180, 181
Status Bar 98
stimulus 14, 164
Stop value 72
string

model parameter 167
subcircuit 78, 146, 147
subcircuit parameters 78
Subcircuit Properties dialog 78
sweep

DC analysis 138
sweeping

parameter values 71, 74
Switches 169, 171
Symbols

attributes 31
flipping 25
moving 25
placing 21
rotating 25
selecting/deselecting 18
test points 14, 53
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T
TD 141
TEMP 74, 159
temperature 159
temperature coefficients 160
test configuration

editing 81
test configurations 80
test point 14, 19

symbols 53, 54
Test Point Ref Des 54
time delay 141
timestep Control 127
title bar 52
title line 14
TMAX 130, 160
toolbar 71
Total Analysis Time 58, 60
transient

delayed data 159
internal timestep 130

transient analysis 57
running 62

Transient button 60
transition file 181
Transmission Line 142
Transmission Lines 140
TSTART 160
TSTEP 57, 127, 129, 135, 159, 186
TSTOP 58, 160
TwoPort 118
TwoPort network box. 116

U
UIC 162, 163
User Properties dialog 79
User Statements window 35
user-definable parameters 78

V
VCVS 141
vector 93

model parameter 167
VIEW statements 53
Voltage Controlled Switch 171
Voltage Controlled Voltage

Source 140
voltage source

placing 47
Vscale 89

W
Waveform

adding/deleting, real time 90
creating 89
data 53
scaling, Node: field 90
scaling, real time 89

Waveforms
real time 89

WIRE
subcircuit 76

WIRE subcircuit symbol 78
wiring parts 26
Wiring Tool 19
wizards 57

Z
Z 137
Zo 141
zooming

function keys 20
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schematic 20
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